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Introduction

Welcome to 3DF Zephyr
3DF Zephyr allows you to reconstruct 3D models from photos automatically. The
process is entirely automatic, and no coded targets, manual editing or special equipment
are needed. 3DF Zephyr is built on top of our proprietary, cutting-edge, reconstruction
technology. 3DF Zephyr comes with a user-friendly interface, and the possibility to export
in many common 3D formats or even to generate lossless video without the need for
external tools. Furthermore, 3DF Zephyr has a lot of advances functionalities, and you
can, for example, edit your models, create true orthophotos, digital elevation models
(DTM), manage laser scan data and calculate areas, volumes, angles, contour lines, and
much more.
Here in 3Dflow, we worked hard to build up both the core technologies and the user
interface. The obtained solution is in all probability the most accurate, completely
automatic, best engineered multiview-stereo algorithm available on the market.
If you need further help, if you would like to request features or if you want to discuss the
product and the technology behind it, please remember that our forum
(http://forum.3dflow.net) is always willing to receive new users.
Before starting, you might want to read some hints and tips on how to take the 'correct'
photos and an overview of the reconstruction process.
If you prefer you can also jumpstart and directly Start a new Project.
Moreover, please note that there are also free online tutorials available, featuring demo
datasets you can download and more in-depth tips and tricks: our tutorials are available
at the URL http://www.3dflow.net/it/technology/documents/3df-zephyr-tutorials/
At the URL www.3dflow.net/account there’s the opportunity to create your own 3Dflow
Account: with these credentials you can access both to your private area and our forum.
In the private area you can open support tickets, submit a bug report, request a beta key
and manage the licenses tied to your specific email. From this area, if necessary, you
can also deactivate autonomously your license: all you will need to do is to reset the
license remotely and activate it on another computer.

System Requirements
3DF Zephyr is a computationally demanding application. It takes advantage of all
available CPU cores, and it makes use of the Nvidia CUDA technology where available.
Please note that a CUDA enabled Video Card can drastically improve performances
(multi GPU configurations are supported as well in Lite, Aerial, Pro). We also suggest
exiting all running applications when performing a reconstruction with 3DF Zephyr.
Minimum System Requirements:
OS: Windows 10/8.1/8/7/Vista (64 bit)
Processor: Dual Core 2.0GHz or equivalent processor
Memory: 16GB System RAM
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Hard Disk Space: 10GB free HDD Space
Video Card: Direct X 9.0c compliant NVIDIA video card with at least 1GB of RAM
Recommended System Requirements:
OS: Windows 10/8.1/8/7/Vista 64 bit
Processor: Quad-core Intel or AMD CPU
Memory: 32GB System RAM
Hard Disk: 20GB free HDD Space - SSD drive
Video Card: Direct X 9.0c compliant NVIDIA video card with at least 2GB of RAM and
CUDA capabilities >= 3.0

Versions
3DF Zephyr is the complete photogrammetry software solution.
Since version 5.0, the old "3DF Zephyr Pro" and "3DF Zephyr Aerial" versions have been
merged into one single version, called "3DF Zephyr". "3DF Zephyr Aerial" keys are
automatically valid for the current complete "3DF Zephyr" Version, while you may need to
convert your existing "3DF Zephyr Pro" key. Please contactsupport@3dflow.net for any
question you may have!
Our two additional flavors, "3DF Zephyr Lite" and "3DF Zephyr Free" remains the same.
3DF Zephyr is the complete photogrammetry software solution dedicated and designed
for topography, urban monitoring, natural hazard, mining, UAV, precision agriculture
applications, architecture, archaeology, medicine & dentistry, body scanning, vfx and
much more.
3DF Zephyr Lite/3DF Zephyr Lite Steam Edition is a commercial solution aimed at
small businesses, artists or in general to those users who just want to obtain a 3D mesh
and/or those who don't need all the tools available in the complete edition.
3DF Zephyr Free is a completely free edition, excellent for sharing your project files with
customers, friends and colleagues. Although it has serious computation limitations (for
example,a maximum of 50 pictures can be used) it is still a great viewer and the perfect
way to learn the ropes of photogrammetry.
3DF Zephyr and 3DF Zephyr Lite require online activation. 3DF Zephyr Lite Steam
Edition must be run through the Steam application.
3DF Zephyr is also available as an education version, with the same functions and
features but without a commercial licensing. 3DF Zephyr Education is dedicated to
students, teachers and schools.
For an updated feature comparisons list, you can refer to the following page:
https://www.3dflow.net/3df-zephyr-feature-comparison/

Activation
3DF Zephyr, 3DF Zephyr Education and 3DF Zephyr Lite editions require online
activation (3DF Zephyr Lite Steam Edition will work through the Steam Application by
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Valve and does not require a product key).
The product keys are supplied by email at the moment of purchase. If you lost your
product key, please get in touch with our technical support so that we can resolve your
issue.
You can activate your software either during installation or on the first run.
The activation process will bind the product key to the computer.
Usually, a product key can be activated only on one computer at a time. You can
deactivate the software from a machine from the "help" menu.
If you have problems regarding online activation or deactivation, please email
support@3dflow.net - a manual offline activation process can also be issued in special
cases.

Documentation

3Dflow put a lot of effort into making make Zephyr's interface as user-friendly as
possible.
However, if you want to get the best results, please spend a few minutes reading the
hints and tips you will find in this documentation.
This guide is intended for all the different versions of 3DF Zephyr unless stated
otherwise.
In the next section, we will quickly review the reconstruction process. It is not essential to
fully understand the "magic" behind Zephyr, but a quick review of the main concepts can
be useful.

A Quick Overview
Here in 3Dflow we are, first and foremost, Computer Vision researchers. Computer
Vision is, generally speaking, the science that studies how to extract (any kind of useful)
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information starting from images. This is a very rough definition and many subproblems
can be delineated and many different meanings for the concept of "information" can be
given. Extracting three-dimensional models from a number of images (extracting 3D
information from a 2D input) is a well-studied problem in Computer Vision. 3DF Zephyr
represents a highly refined and well-engineered solution for this problem.
There are three main phases in Zephyr:
· Starting a new project and defining the camera pose - this is also referred as
'Structure from Motion'
· Generating 3D model
o Extracting a Dense Point Cloud - this is also referred as 'Multi-View Stereo'
o Extracting a Surface
· Extracting a Textured Mesh
When starting a new project the software will extract the camera external parameters
(positions and orientations) and their internal parameters (i.e. the focal length and other
camera properties). All the magic of this phase is done by Samantha, our leading
Structure from Motion Technology. If you want to input the internal camera parameters
manually instead of letting Samantha estimate them, you can.
After the cameras have been oriented, you can proceed and generate the 3d model. This
step goes through two phases :
- Extract a dense reconstruction. The process requires the input cameras to be correct.
If you believe a camera is not correctly oriented, you can remove it from the workspace.
Before proceeding you can also restrict or expand the volume of reconstruction. The
densification stage is managed by Stasia, our Multi-View Stereo technology, powers the
reconstruction process. You can create different dense reconstructions (with varying
parameters) and save them into the workspace.
- Create a triangular mesh, starting from a dense reconstruction. Based on what you are
going to reconstruct you can choose from either the generation of a smoothed surface
(when dealing with human body or terrains for instance) or the generation of a sharp
surface that more benefits scenes such as buildings or mechanical parts. The latter kind
of surfaces are handled by Sasha, the meshing algorithm developed by 3Dflow.
Every mesh polygon gets textured using the most appropriate pictures according to their
visibility and quality. Within the texture generation phase there is a color balance
algorithm as well, that allows the user to select and set-up the best color for each pixel
automatically by checking the different lighting changes on the photos.
In the next section we will give some hints and tips on how to take the right photos.

Photography Guide
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In this section we will list some tips to obtain good reconstructions. 3DF Zephyr is
completely automatic but does require some forethought to produce the best results.
Camera sensors.
Please bear in mind when picking your gear:
·
·

camera performance is not determined by its megapixel resolution;
high-end cameras do not always lead to better results;

A good camera must allow full light management in order to control each exposure value.
That is why DSLR cameras (colloquially also referred as "reflex") are usually
recommended even though also mirrorless cameras and bridge cameras can fulfill that
need.
The camera sensor is the crucial factor and the following hints may be helpful:
·

Pixel size must be higher than 2 µm; therefore it is strongly recommended to use a
camera with a sensor bigger than 1/2.3" even though smaller sensors may be used
depending on the accuracy you want to reach;

·

Pay attention to pixel size rather than pixels count for each picture. For instance, if a
36 megapixel full-frame reflex (35.9 x 24 mm) is being used it is advisable to shoot at
a lower resolution than the maximum provided. It is better to get bigger pixels in the
images even though fewer;

Lenses.
Every survey has its own features and conditions so choosing the most suitable lens
depends on both environmental conditions (light, obstacles on field, user movement
capability) and features of the survey subject/scene. The following tips are provided to
pick the proper photographic gear:
·

Full-frame cameras: use lenses with a focal length between 25 and 50 mm;

·

Cameras equipped with an APS-C sensor or with a lower sensor size: use lenses
with focal length values between 18 and 35 mm, considering a crop factor value
between 1.5 and 1.6;

It is strongly recommended to keep shooting the same focal length for all the pictures
you take. Even if Zephyr can handle several kind of cameras and lenses at the same
time and in the same project, you can get better and faster results if working with a
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consistent set-up;
Shooting techniques.
The techniques for capturing images need to be adapted depending on the subject
matter and situation. Below are some suggestions for common situations.
Parallel axis capture

Use this technique with planar or regular surfaces in application fields such as architecture and
aerial photogrammetry. White triangles indicate the camera positions and their field of view.

Convergent axis capture

Use this technique when it is possible to move around the subject/scene

Interiors capture

9 / 135

3DF Zephyr

Use this technique when capturing interiors.

If a small or medium size object is to be fully reconstructed it is possible to keep the
camera in a fixed position (on a tripod for instance) and to put the object on a turntable.
Then 3DF Masquerade will enable the background in the pictures to be hidden.
General rules.
·

Keep the subject in the center of the frame;

·

Avoid direct light sources that may cast shadows and hide surface areas;

·

Avoid high ISO values since the noise may adversely affect the Structure from Motion
phase in Zephyr;

·

Keep high aperture values (f/8 - F/16) when possible, as it helps get a wide depth of
field on pictures;

·

Avoid blurry photos. Using good quality cameras as well as having good lighting setup
can help. Consider also using a tripod if necessary.

·

Have lots of overlap between each photo (70-80%). This is probably the most
important tip. Shoot as many photos you can. Each part of the scene you're shooting
should appear in at least three separate views taken from different locations. This is
a minimum requirement, taking more photos will probably improve the final results.

·

Limit the angles between photos. When moving around objects, try to keep the angle
between each photo very low.

·

Shoot scenes with lots of detail and texture. The visual texture in the photos is what
ties them together. 3DF Zephyr does not work well with uniform or highly repetitive
texture and does not work at all with specular or transparent objects. You can,
however, mask out certain areas using 3DF Masquerade (bundled with 3DF Zephyr).
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·

Don't try to adjust lens distortion as that error is quite essential during the first phase
of Structure from Motion;

·

Even if 3DF Zephyr can deal with different cameras or lenses within the same
dataset, you will obtain better results by using the same camera with the same focal
length.

·

The more photos you take, the better results you will get: having redundant
information will help Zephyr.

Remember that you can use the Image Quality Index inside Zephyr to check the status
of the pictures you are working on.

The Main Window
When opening Zephyr, the interface layout will look like this:

On the upper side, the menu bar and the toolbar give you access to all the basic actions
and functionality of Zephyr.
The Render window at the center lets you navigate through the 3D scene. You can also
right click on it to open a contextual menu to perform specific actions.
The other windows are completely "dockable"; this means you can move and dock them
in any part of the main window. To hide or show a specific dock use theView menu.
An optional toolbar can also be shown at the top or bottom of the 3D scene. This toolbar
can give quick access to picking and measurement tools (not available in 3DF Zephyr
Lite and 3DF Zephyr Free).
3DF Zephyr always saves and loads the interface layout of your last run. FromTools >
Options > Application > Restore Settings you can restore the factory default settings
(including the interface layout).
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On the left side, in the Project tab you can review all the objects currently loaded in the
workspace. The Objects are divided into 4 categories: cameras, sparse point cloud,
dense point clouds and meshes. You can remove, rename and edit every object by right
clicking on them and selecting the specific action.
The Navigator tab helps you navigate through workspaces.
On the left side you can find the Animation tab, where you are able to create and export
video animation of your 3D models.
On the right side there are the Control Points tab, the Measures tab, the Registration
tab, and the Editing tab as well.
On the same tab, the History tab lets you review, undo and redo the performed actions.
The Navigation bar is located at the bottom alongside the thumbnails of the photos
loaded in Zephyr and the Log panel.

Starting a new project
Got the photos? Then you are ready to begin the reconstruction process!
To create a new project, just click on Workflow > New Project (1) . The Project Wizard
(2) screen will appear which will guide you through the process of importing your
pictures.

For standard workflow you simply click on the Next button and continue adding your
photographs within the software.
However, in that wizard there are three submenus :
- Generation Options (3)
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- Imports (4)
- Additional options (5).
Let's have a look at what they mean.
In the "Generation Options" panel you have the possibility to queued the other phases
of reconstruction pipeline until the generation of textured mesh.
Inside the Imports menu you have two advanced options:
·

Import control points constraint: this option allows you to import 2D image
coordinates and 3D spatial coordinates for Ground control points from txt files. The
Control points will be used to adjust the reconstruction. Please note that you can
alternatively select and import the control points coordinates after the creation of
sparse point cloud from the "Align model with 3D coordinates" menu.

·

Import camera position constraints: as the previous option, this one allows you to
import camera position (by loading a txt file) in 3DF Zephyr and to use them to
constrain the 3D reconstruction; a standard example of practical usage of this entry is
represented by the pictures taken by drone or UAV system record recording GPS
coordinates of the shots into the Exif data. Please note that you can alternatively
import camera positions after the creation of sparse point cloud from the "Align model
with 3D coordinates" menu.

In the Additional options submenu (4) you can instruct the software to perform each of
the four 3D reconstruction phases without stopping between one phase and the next; this
tool can be very helpful when you don't have enough time to monitor each stage of your
3D reconstruction. This technique is called batch processing and is only recommended
for advanced users, as it represents the highest level of automation in 3DF Zephyr.
You may also select to instruct Zephyr to use masks. Masking is a technique which
allows you to specifically ignore parts of a subject, very useful for example with
reflections, moving objects or any other cases where the background is no longer
coherent with the subject. If you are moving your subject or using a turntable, you
need to mask your images. Refer to the 3DF Masquerade chapter for more
information.
In Additional options (4) the Check online for precomputed camera calibration
option allows Zephyr to connect to our 3DF Zephyr online database: the software will be
able to automatically download the pre-calibration parameters thereby reducing the
duration of the Structure from Motion phase.
In the previous submenu, you can also load the masks related to photographs, if these
have been previously generated with the 3DF Masquerade tool. After clicking Next the
Masking page will appear(see image above) and it will specify whether the masks have
been properly loaded into 3DF Zephyr (a green "Ok" should appear close to the picture's
name, for each imported mask) or not.
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By selecting the Ignore masking during orientation option 3DF Zephyr will not
leverage the masks in the first phase (structure from motion); this tool is useful if the
image background is well textured and can therefore help the first phase of cameras
orientation.
The next window is the Photos selection page, where the user is asked to load the
pictures:

It is possible to drag 'n' drop the files into the window or to click on the "+" Button to
select a photos directory. You can also directly add a specific directory containing the
desired pictures. You will most likely use JPGs or PNG, but you may also use raw file
formats such as NEF, CR2, ARW2, etc - remember that raw files are generally slower to
load.
3DF Zephyr allows you to import both images and videos through the Import from video
images button; this tool can split videos into frames which are subsequently treated like
any other image would.
If this option is selected, you can select the desired file and then to specify the
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destination folder where it will save the set of extracted frames. In the options below you
can set the frame rate to be extracted (FPS), the blur analysis on each frame and the
threshold of identification, and rejection, of similar frames. Also, you are allowed to cut
those parts of the video data you don't want to consider into the frames extraction.

Similarly, you can use the "Import from panorama" picture tool in case you are using an
equirectangular image format: simply select the images using the "plus" button and select
which sides of the equirectangular image should be converted into which "sides".
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After loading the images or video files and clicking on Next button, you will see the
Camera calibration page where you will notice a list of every single imported image as
well as the calibration that 3DF Zephyr will use for each camera and its EXIF data.
By right-clicking the window you can select or deselect all the images, and clone
calibrations.
From this page, you can Add a New Calibration, or eventually modify the Calibration
that 3DF Zephyr has automatically identified through the Exif data of the photographs.

Zephyr is 100% autocalibrated however, so in most cases you don't have to do anything
at this point. However, it's important to understand what you can do, in the event you
need to tweak these settings.
In the Modify Calibration page, you can select the focal length you want to change (if
loaded pictures have been taken with different focal lengths) and then define the
calibration parameters.
By the Import parameters from file button you can load calibration files created with an
external applications (for example the old 3DF Lapyx or the 3DF Zephyr embedded
calibration tool).
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By the Import parameters from calibration manager button, you can choose the
desired parameters from the calibrations loaded by the user within the Camera
Calibration Manager, present in the Utilities menu.
TIP: If you have imported pictures taken with wide-angle or fish-eye lenses and having
issues with the camera orientation phase, it is recommended to activate the Adjust
tangential distortion parameters option from the modifiy calibration dialog.
Once the calibration step has been completed you have to set-up the first phase of the
3D reconstruction by means of the Camera orientation settings page, which will
generate a sparse point cloud as initial 3D result.
There are three settings way for the first three phases of 3D reconstruction:
- Categories and Presets: is the fastest way to set the parameters of the
reconstruction;
- Advanced Mode: allows you to define every detail of the 3D reconstruction phases;
- Custom mode: let you modify all the parameters of the reconstruction engine - only
for expers
It is possible to use categories and presets, advanced mode and custom in every stage
of the 3D reconstruction whether used in the previous phases or not.

Cameras orientation
The first phase of 3D reconstruction is called Structure from Motion and it is responsible
for defining the position and orientation of each photo that has been loaded in Zephyr.
This step yields a sparse point cloud as initial 3D product.
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Depending on the selected Preset category it is possible to choose from three quality
values (fast - default - deep) that gradually increase the capabilities of the Samantha
algorithm managing this first phase.
You can switch to advanced mode to define each parameter of Structure from Motion
phase in detail. To do so, simply select "Advanced" from the "Settings" drop-down
menu.
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Keypoints Sensivity: keypoints represent the matched pixels in the pictures. This
parameter allows you to set the number of keypoints that 3DF Zephyr will have to extract
for each photo; nevertheless a substantial number of keypoints does not lead to a
better result, since the more elements involved the higher the ambiguity during
correspondence detection between the keypoints themselves.
Low:

extracts up to 5,000 keypoints per image

Medium:

extracts up to 7,500 keypoints per image

High:

extracts up to 10,000 keypoints per image

Very High:

extracts up to 15,000 keypoints per image

It is recommended to decrease keypoints density when:
- a computed result is required quickly;
- the distance between cameras and subject/scene on survey does not change;
- pictures have a high overlap percentage (70% - 80%);
It is recommended to increase keypoints density when:
- Cameras are not correctly oriented;
- There are some pictures too close or too far from the subject/scene;
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- The dataset includes a few photos that have a low percentage of overlap;
- The subject/scene has a uniform surface and no texture (a white wall for instance);
Matching Type: allows you to select different kinds of matches between the keypoints in
the images. The accurate option requires more time to complete;
Matching Stage Depth: sets up how many matches are performed on the images
between the keypoints. By setting this parameter to the higher value, the capability to
align multiple images at the same time is going to increase, as is computation time.
It is recommended to decrease the depth value of the matching stage when:
- a computed result is required quickly;
- The distance between the camera and subject is not high;
- The overlap percentage between different shots is high (70% - 80%);
It is recommended to increase the depth value of the matching phase when:
- Cameras are not correctly oriented;
- There are some pictures too close and too far from the subject/scene;
- The dataset counts a few photos that have a low percentage of overlap;
- The subject/scene has a uniform surface and no texture (a white wall for instance);
Photo Ordering: this parameter informs the software which what methodology was
used during image capture in the field and therefore the sequence of the pictures taken .
This can speed up the near images detection process. By using sequential option the
photos have been taken following a numerical order (photo 1 near photo 2 - photo 2
near photo 3 and so on), while circular option indicates a loop sequence. If you are
aware that the photos have been taken with a specific order, you can streamline the
process by choosing among those two options, otherwise you can consider thesparse
option. The last option is called approximate grid and it was designed for data
acquisition collected from drones or UAV systems, and it is exploited when capture is
sequential and has a high percentage of overlap between the pictures (70% - 80%).
Point quantity: this value affects the number of points to be considered during the
Bundle Adjustment optimization. More points can lead to better results, but at an
increased computational cost.
Reconstruction Engine: 3DF Samantha supports both incremental and global
reconstruction pipelines. The global pipeline tries to solve the orientation problem
globally, which means that it's usually faster than the incremental one and potentially be
less prone to drifting error. The incremental engine on the other hand, albeit slower,
tends to be able to include more cameras in the final solution. In a nutshell, you'd should
use the global pipeline if you are processing a huge dataset (more than 1000 pictures).
Bounding box method: it defines the computation method of the bounding box. It's
usually recommendable to keep the default option "discard outliers", which are those
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"weak" points that are not relevant to the 3D reconstruction.
A further description of those parameters is available here: http://www.3dflow.net/3dfzephyr-parameters-tuning-guide/
You may also switch to the "Custom" mode by selecting "Custom" from the "settings"
drop down menu. This mode allows you to fine tune in detail every single reconstruction
parameter. Remember that you can load an XML file or reset to default by right-clicking
and selecting the desired option. Please also note that a hint regarding the selected
parameter is shown at the bottom of the window.

At the end of the first phase of cameras orientation you will see both the sparse point
cloud and the pictures sequence around the point cloud.
Photographs in the render window are identified by blue stylized cones whose graphics
are editable in Zephyr Options.
ACCURACY EVALUATION OF CAMERAS ORIENTATION PHASE
After the first step of 3D reconstruction is completed it is advisable to check its accuracy
in order to figure out which pictures should be discarded to decrease the error even on
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further phases.
By clicking on Tools > Workspace > Camera Stats the following chart will appear:

The column in the middle shows the mean reprojection error related to each picture,
while the "Point Seen" column indicates the number of keypoints (namely the points for
which the software was able to retrieve the position) detected in each photo. By clicking
on the entries Mean Reproj. Error and Point Seen users are able to sort the values in
both decreasing and ascending order.
Generally a well-oriented picture with a good accuracy degree will have a low
reprojection error as well as many points seen. Points seen represent the equations
amount exploited during reconstruction phase, so their high value is related to a higher
reliability of final result. It should also be noted that the reprojection error does not
provide a precise degree of the result since it always has to be correlated to the sensor
size of a camera rig.

The bounding box
When a 3D model is reconstructed by Zephyr, the corresponding bounding box will be
computed as well. A bounding box is defined as the volume in which all points that do not
fall into said volume will be discarded.
You can then change how Zephyr behaves by changing the bounding box settings (not
just for "what" is being reconstructed, but also the discretization level changes when the
volume changes too).
You can enable rendering and edit the bounding box either from the Scene menu or by
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clicking the appropriate icon in the top toolbar.

Once enabled, the bounding box will be visible in the 3D viewport and the bounding box
edit widget will appear on the screen. Using this widget, you can toggle the bounding box
controls.
We suggest to enable the bounding box as soon as you complete the sparse point cloud
generation, so that you can make sure it has been computed correctly and eventually fix
it if it is too large or too small.

Translate: click and drag the desired gizmo to move the bounding box over the selected
axis.
Rotate: click and drag the desired gizmo to rotate the bounding box over the selected
axis.
Scale: click and the desired face of the bounding box to scale the bounding box.
Reset/smart rest: resets the bounding box (the smart reset will try to automatically fit the
bounding box to the computed point cloud).
Adapt: it allows to adapt the bounding box to one of the objects present in the
workspace (sparse point cloud, dense point cloud, mesh, etc.).
Always show the bounding box: keeps the bounding box rendered in the scene even
when the bounding box widget is closed.

3D Model Generation
To start the process simply click on Workflow > 3D Model Generation or click on the
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corresponding icon in the toolbar after the camera orientation phase has been
completed.

Tip: Before starting the generation, it is possible to restrict or vary the reconstruction
area by changing the Bounding Box. This step is an optional one as the Bounding Box is
automatically generated. By restricting the reconstruction area around your 3D object
you can improve the results and speed up the computation time.
As with the first phase of camera orientation this second phase of the 3D reconstruction
can be set-up by using categories and presets, or switching to the advanced mode.
Below we will explain the meaning of the presets, for advanced settings we can refer to
this document for dense point cloud, and this document for mesh generation. The
categories are common to both phases.
Two wizards will be proposed for the selection of presets, one for the dense point cloud,
one for the mesh:

Categories Dense point clouds
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- General : Category that works in most cases, to be used even when you are
undecided about which preset to use.
- Aerial - Nadiral images : Use this category when you are reconstructing a top-down
view scenario, typically a drone acquired dataset.
- Urban : Use this Category to reconstruct from images of an urban environment, you
can also use this category in the case of images from different cameras and / or different
focal lengths.
- Human Body : Category optimized for parts of the human body or full figure.
- Surface Scan : Use this category to reconstruct flat surfaces close-ups, like terrain or
ground.

Presets Dense point cloud
- Preview : This preset skips the Stereo phase and uses the sparse point cloud as
dense point cloud.
- Default : To be used in most cases.
- High details : Higher resolution, slower but produces a more dense point cloud.
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Categories Mesh generation
- General : Category that works in most cases, to be used even when you are
undecided about which preset to use.
- Aerial - Nadiral images : Use this category when you are reconstructing a top-down
view scenario, typically a drone acquired dataset.
- Urban : Use this Category to reconstruct from images of an urban environment, you
can also use this category in the case of images from different cameras and / or different
focal lengths.
- Human Body : Category optimized for parts of the human body or full figure.
- Surface Scan : Use this category to reconstruct flat surfaces close-ups, like terrain or
ground.
- Laser Scan : Use this category to extract meshes from laser scans point clouds.

Presets Mesh generation
- Preview : Default settings with no photoconsistency optimization.
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- Default : To be used in most cases.
- High details : Increased resolution during photoconsistency, slower but produces a
mesh with more polygons.
- Ultra : Max. resolution during photoconsistency. Requires much more computation time
than the "High Details" presets and produces a mesh with a lot of polygons. This preset
should be used only in very specific cases.

Once the parameters are chosen you can start the process by clicking on Run button.
The dense point cloud generation places the greatest demands on hardware capabilities
along with the cameras orientation phase.
Don't forget that you can reconstruct and add more dense point clouds in the same
Zephyr project, even exploiting different parameters or reconstruction volumes.

Texture generation
In the last fourth and last phase of 3D reconstruction by Zephyr it is possible to start the
texture generation on a 3D model by clicking Workflow > Textured mesh generation.

From Zephyr 4.5 it is possible to select presets and categories also for the texture
generation, or you can change the texture generation settings directly from "advanced"
settings after selecting the mesh on which you want to apply the texture and which
cameras will be considered for the texture extraction. While generally speaking you
will most likely use all the cameras, it is sometimes very useful to remove certain photos
(for example when they have a very different lighting condition).
Below the wizard window that allows to select Categories and Presets.
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Category
- General : Category that works in most cases.

Presets
- Low Poly : Will generate low poly, single textured mesh.
- Default Single Texture : Single textured mesh with default parameters.
- Default Multi Texture : Multi textured mesh with default parameters.
- High details : Multi textured high resolution mesh.
By selecting the "Advanced" setting this wizard will appear:

28 / 135

3DF Zephyr

In the settings window the user can set up the following parameters:
·

Max. texture Size: sets the maximum size of the texture. Please note that a
power of two value is not guaranteed, as it is just a higher limit value, although
Zephyr will make it a power of two when the input images allow to do so.
Nevertheless, it's possible to select a resize when exporting the textured mesh
(see "Export menu").

·

Maximum number of textures: defines how many textures will be generated.

·

Generate 32 bit textures: enable this texture to save as 32bit textures. If
unsure, leave this unchecked, as it is used in very specific workflows.

·

Maximum number of vertices: this defines how many vertices of the mesh are
involved in the texturing generation process.

·

Image resolution: allows the user to set the percentage of the resolution that
will be used int the texture generation process.
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·

Color balance strength: you can set the color balance strength depending on
the light conditions in the images that have been used, keeping it limited from
very controlled scenarios (e.g. turntable) to aggressive (lot of lighting changes).

·

Use blurriness detection: every camera contribution for each triangle will be
weighted depending on its blurriness. This is useful if, for example, some of your
photos are slightly out of focus (e.g. just on the background).

·

Sharpness filter: weight of the sharpness filter that should be applied to the
output texture(s).

You can see the generated UVs on the texture(s) by right-clicking the generated element
in the left panel under "Project" - "Textured Mesh and selecting" - "Show UVs".
Generated UVs are wrapped, so remember you can export a mesh, define your own UV
mapping in an external software (e.g. blender) and then re-import said mesh and
regenerate the texture using your own custom UVs from the "Import" - "Import mesh with
UV map" menu.

Extracting a dense point cloud
To start the process simply click on Workflow > Advanced > Dense Point Cloud
Generation or click on the corresponding icon in the toolbar.
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From 3DF Zephyr 4.5 it is possible to access the generation of the dense cloud from the
"Advanced" menu if desired. Note that after the generation of the 3D model, repeating
the dense cloud generation using the generated model itself as an input for the dense
cloud generation algorithm, may yield better results as consequence of having applied
the photoconsistency based optimization algorithm.
Below is an explanation of the advanced parameters, having already dealt with the
presets here.
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·

Image resolution: this defines the resolution used for the pictures. A higher resolution
keeps more details, but it may produce noisy results if the photo quality is low. The
time required for the dense point cloud generation is strictly related to this parameter.

·

Number of nearest cameras: the number of cameras used to create depth maps
that is also linked to the number of pictures taken. You should increase that value if
you calculate that there are N photos, for each camera, that are aiming at the same
point of the scene. Increasing the number of cameras may increase the processing
time.

·

Speed up level: this parameter has been added in Zephyr 4.2, and allows a speedup
factor that can be determined by preemptively discarding redundant pixels.

·

Noise filtering: low values will produce much denser clouds but with noisy areas,
whereas high values will produce cleaner clouds with fewer endpoints.

·

Update Colors: Update colors after computation.

·

Shape from Silhouette: (feature present only in the full version of Zephyr) this is an
image-based modeling technique that uses the profile, or silhouette, of the subject to
create a virtual hull containing the subject. You must create the masks for all the
pictures before running the densification phase using this option. This technique can
be quite worthwhile when you need to deal with transparent or reflective surfaces
which cannot be removed with 3DF Masquerade.

·

Discretization Level: this parameter defines the level of accuracy of the dense cloud
when is extracted from masked images. Higher values will produce a more defined
dense cloud, whereas lower values might be the best choice when masks are not
super accurate.

Once the parameters are chosen you can start the process by clicking on Run button.
A further description of the parameters above is available here:
http://www.3dflow.net/3df-zephyr-parameters-tuning-guide/

Extracting a mesh
Click on Workflow > Advanced > Mesh Extraction to start the mesh generation
phase.
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In the new window you need to select the dense point cloud you want to exploit to start
the mesh generation. That is because you can create more dense point clouds in
Zephyr.
In the following page you can see the reconstruction settings. You can choose if select
categories and presets or enter the advanced setup mode as in previous phases of
reconstruction.
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·

Watertightness: higher values will tend to close more holes.

·

Update colors: Update mesh colors after computation.

·

Out of Core: With Zephyr 5.0, the Out of Core technology is integrated to grant a
certain level of detail for the mesh generation and, at the same time, allows
computers with a lower amount of memory to compute bigger datasets in an
optimized way. It is possible to set the Minimum amount of vertices for the mesh
you want to generate and the Discretization Factor according to your needs: lower
values (e.g. 1.0) leads to a greater amount of detail of the mesh but it could introduce
more noise as well. On the contrary, setting higher values, the final mesh will less
noise and a less amount of triangles. By default, the discretization factor is set to 1.5,
which is a good trade-off between mesh details a noise control.

·

Photoconsistency Based Optimization: this option controls the photoconsistency
based mesh optimization. This will generally improve the details extracted of the
mesh, and although it will require some computation time, it's generally worth using it.
You can set the image resolution: usually (but not always) you can get better results if
the image resolution of the photoconsistency based optimization is higher than the
resolution used in the stereo step. You may also run the photoconsistency mesh
optimization as a mesh filter from the tools menu.

You can start the mesh reconstruction by clicking on Next and then on the Run button.
Timing may vary depending on the total number of polygons you have previously
selected.
You can create several surfaces in the same Zephyr project using different parameters.
A further description of the parameters above is available here:
http://www.3dflow.net/3df-zephyr-parameters-tuning-guide/

Mesh enhancement and densification
Polycount alone is never a good heuristic to understand the quality of a 3D
reconstruction. However, there are some specific workflows where it is necessary to
obtain very dense mesh (we are talking hunderd millions of polygons) in order to
generate displacement maps or for similar post processing techniques. If you are
wondering why you may need such a high polygon count, then you most likely do not
need this feature and can happily skip this paragraph.
Since 3DF Zephyr 4.0, a new additional step after the textured mesh generation, called
“Generate and export enhanced mesh” is available in the workflow > Advanced menu:
this is not a photogrammetry process but rather a post processing that can lead to
what is commonly known as fake detail (for example, a drawback is that tattoos gets
heavily carved in human bodies as well as plain text gets carved in papers, etc).
This process is not aimed to engineering, science and survey users of 3DF Zephyr
or any other field where accuracy is important. Although it is more prone to high
frequency noise, this densification process to many millions (or in very niche workflows,
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even billions) polygon can be useful sometime.
Below a simple example from a 35 photos dataset that has been enhanced from 2 million
triangles to almost 100 millions: on the left, the raw textured mesh and on the right, the
enhanced textured mesh. In this case, the enhanced method wasn’t very helpful as all it
did was extract more noise.

However in some cases, for example when there are a very low amount of camera that
see the same point, this feature may extract “fake” detail that is actually noticeable
(albeit some additional noise). This is a similar example (31 images) enhanced from
370.000 triangles (left) to 4 million triangles (right).

As a final note, the high frequency gain is not mandatory (as it is controlled by a
parameter from 0% to 100%) so eventually, this feature can be used simply to densify a
mesh or a textured mesh to an arbitrary polycount if desired (the other densify tool
already available in Zephyr works differently and is capped to 50M points)

35 / 135

3DF Zephyr

Starting a project from a video
3DF Zephyr can work with images as well as videos. Although videos have a lower
resolution, having a continuous video feed ensures overlap, making some datasets much
easier to acquire that way. 3DF Zephyr will almost always yield better results with
photos, but it's a useful feature to keep in mind.
3DF Zephyr offers an intelligent frames extraction tool: in the new project wizard, simply
select "import from video" and the following window will appear:

Zephyr will automatically extract frames from videos ( you can set a sampling rate
indicated as frames per second or simply extract all the frames of the video, based on
the framerate of this one ) and treat them as normal images. Missing EXIF data is not a
problem for Zephyr, as it is 100% autocalibrated. However, providing a manual device
calibration may help, especially when dealing with fisheye lenses such as those of action
cameras.
You can also enable a blurriness auto-filtering, which will discard frames that are too
blurred and an auto similarity discard filtering, which will automatically discard frames
that are too similar between each other.
The "frame queue size" is used to define the amount of memory to be used for frame
queuing.
You may also use the frame preselection toolset to only select a specific part of the
video.

Project Panel
The Project panel is located in the left sidebar of the main Zephyr interface. This panel
gathers the most important parts of the .zep file.
In the Cameras section you can find thumbnails of the images imported in Zephyr, both
those that were successfully oriented and those that failed the orientation step. By
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double-clicking with the left mouse button on a thumbnail the properties window will
appear with:
·
·
·

information about the resolution and the position in the Zephyr coordinates system
internal calibration parameters
statistics about the keypoints that Zephyr managed to find during the SfM phase and
the mean reprojection error;

By right clicking one or more pictures it is possible to:
·
·
·
·
·
·
·

try again to re-orientate the cameras that have not been orientated
see the picture as an overlay, by changing the point of view
see the picture thumbnail at a bigger resolution
rotate and rename the camera thumbnail
change the camera picture file
change the mask linked to the camera
open the properties window
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·
·

export external and internals parameters of the cameras
export the undistorted images

The Sparse Point Cloud, Dense Point Cloud, Meshes and Textured Meshes
sections all allow users to access the properties of the reconstructed 3D object (doubleclick with the left mouse button) which will show:
·
·
·
·

statistics about the point cloud/mesh with the total number of points/polygons
information about the generation process of the cloud/mesh (settings, running time,
Zephyr version, generation date and time)
detailed data about the reconstruction settings as they can be used in .xml files
the log file about the reconstruction phase

Tip: in the sparse point cloud properties you can find the Mean Square Error which
shows the quality of the reprojection in the orientation phase. As a rule of thumb, when
this value is lower than 1 then the orientation can be considered valid and you can
proceed with further steps. With values higher than 1, you may want to execute again the
orientation phase by:
·
·

excluding pictures with a very high reprojection error (you can find that value in the
properties of each single camera)
adding control points on the images, exporting them, and then using them as
constraints in the first phase.

By right-clicking the generated sparse point cloud it is possible to:
·
·
·
·
·

rename the sparse point cloud
reset the bounding box volume
export the sparse point cloud
view the sparse point cloud properties
Modify the order of elements in the project tab

By right-clicking the generated dense point cloud it is possible to:
·
·
·
·
·

rename the dense point cloud, clone it or delete it
export the dense point cloud
see confidence information (3DF Zephyr Pro and 3DF Zephyr Aerial only)
view the dense point cloud properties
Modify the order of elements in the project tab

By right-clicking the generated mesh it is possible to:
·
·
·
·
·

rename the mesh, clone it or delete it
export the mesh
compute the mesh volume (this feature is not present in 3DF Zephyr Lite and Free the value will be saved in the mesh properties)
view the mesh properties
Modify the order of elements in the project tab
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By right-clicking the generated textured mesh it is possible to:
·
·
·

rename the textured mesh, clone it or delete it
export the textured mesh
view the textured mesh properties

The full version of 3DF Zephyr also features the Drawing Elements subsection, which
will contain sections, contour lines or vector graphics.
By right clicking a generated drawing element it is possible to:
·
·
·
·

rename the drawing element
change the color of the drawing element
export all the drawing elements or those visible/selected
access the drawing element properties

Keypoints animator panel
The Animation panel is located in the left sidebar of the main Zephyr interface. This
function allows the user to easily create demonstration videos of your own models
directly from the Zephyr interface, allowing you to export the video in the most common
file formats (avi, wmv) or by uploading them directly to YouTube.
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In order to create an animation, simply reveal the "Keypoints Animator panel" and click
the "Add Current Position" button, while simultaneously moving the workspace camera
to the desired position. By enabling the "show keyframes" option, every keypoint set will
be shown in the workspace with a yellow cone shape.
When all the keyframes have been placed, you may click the "Play Animation" button to
see the animation preview, or you may edit the duration of each movement between the
keyframes by right-clicking and editing every keyframe or of the whole animation by
clicking the "Set Animation Time" button.
By clicking the "Start Video Recording" Button (represented with the classic recording
"dot" ) a new window will appear (as soon as at least two keyframes have been defined)
which will allow you to edit the movie generation settings: the parameters that can be
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edited are the video resolution (up to 4K), the framerate, the target bitrate and the final
type of the output (on hard drive, YouTube, or both).

Control Points panel
These functions are not available in 3DF Zephyr Lite and 3DF Zephyr Free.
Please, note that every reconstruction is generated with an arbitrary scale, translation
and rotation. This chapter will focus on defining a global scale in order to take
measurements and align the world position, rotate and translate according to userdefined control points.
Control points, alignment and world scaling with known control points (or known
distances) can be managed from the panel on the right labeled "GCP" (Ground Control
Points).
Control point picking on the scene
The easiest way (albeit the least accurate) to insert a new control point is to pick it from
the 3D reconstruction directly.
From the "GCP" panel (1) go to the "Add control point" section and click the "Pick"
button (2). The mouse cursor will be displayed as crosshair (+): move it on the scene (3)
and left click the desired control point position. A new control point will be added to the
control points list (4) and will be automatically shown in the scene.
Note: This control point selection mode cannot be done on a textured mesh.

Control point picking from images
A much more accurate way to add control points is to pick them directly from the photos.
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You need to pick the same coordinate on at least two pictures in order to triangulate and
make Zephyr calculate the control points.
Let's clear the previously created control points by right-clicking on the Point List and leftclicking on “remove all”. Click "Yes" to confirm.
Now, from the “GCP” panel, in the "Add control point" section, click the "From images”
button (1): the “Edit Control Points” window will appear.
From the Camera list (2) left-click a picture to view it in the “Control Point Picker
Selector”. Left-click where you want the control point to appear, and an red dot (3) will
appear. The first selected image will be highlighted by a green border (4). The “OK"
button won't be clickable yet: remember, we need at least two images to define a control
point in the 3D world.
Click on another image in the camera list (2): this time the epipolar line will also appear
(highlighted by the color inversion in the picture), which will help to position the second
coordinate by left-clicking. The current image will be highlighted by a yellow border 5
( ).
The "OK" button will now be clickable - it is possible to add as many coordinates as
wanted (usually, the more coordinates the better the accuracy) and click OK to complete
the control point selection. When changing the 2D position, you can see in real-time the
Global Reprojection error and the Local Reprojection error.

The following functions will help to place control points on images in the control point
editing window:
Fit in view: resize the image to fit in the view
Rotate 90 degrees clockwise, counter-clockwise, reset rotation: rotate
the image and reset the initial position.
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Show magnifier: show/hide the magnifier on the cursor while placing control points
on images.
Show reprojection error: show/hide local and global reprojection errors of the
current control point.
Show epipolar line: show/hide the epipolar line.
Show other points: show/hide previously placed control points.
Automatic matching on current image: find and place a control point on the
current image automatically.
Automatic matching on all images: find and place a control point on all the
pictures automatically.
Detect marker: it allows to automatically detect the center of a rectangular marker
placed in the scene. By clicking the "Detect marker" icon and drawing a rectangle upon
the center of the marker you want to be found, 3DF Zephyr will automatically place the
control point at the center.
Note: Using the tool with a check-board style marker will improve the automatic
detection.
Detect sphere: it allows to detect the center of the spheres placed in the scene. By
clicking on the "Detect sphere'" icon and drawing a rectangle over the sphere you want
to be found in the image, 3DF Zephyr will automatically place the control point at the
center.
Note: This feature is expressly designed for the forensics industry, i.e., to support the
analysis of the line of fire in crime scenes where the spheres on the trajectory rod are
scanned by a laser scanner.
Clear point: remove control points placed on the image.

*TIP*: you can change the camera "Visibility" by selecting the "Show reprojection
cameras" option from the drop-down menu in the bottom left corner of the editing
window. That allows you to place the control points on "far cameras" (dull yellow
frames) as well. In some cases, this method could improve the accuracy, especially
when a few cameras come with and a high reprojection error.
"Show picked cameras" option will shows cameras (green frames) where the control
point is already placed.

43 / 135

3DF Zephyr

The "Pick  Edit" function
From the same menu "Add control point", it is also possible to find the "Pick  Edit"
button: this function allows the user to select a control point by directly picking it on the
scene (exactly like the "Pick" function) and then modify the position of the control point by
editing its position with the "add control point from images" interface, with the control
point already in place in all the possible cameras.
The "Import 2D" function
Importing control points from text files allows the user to automatically add control points
exported from other applications: in order to do that, simply click on the "import control
point" button, pick the desired text file and then click "Open".
A window will appear to confirm that the import phase has been completed successfully:
click OK.
Note: for each imported control point it is necessary to define coordinates for at least
two images. For example, to import a control point named "point1" seen by the cameras
"PictureA.jpg" at the (x,y) coordinates 100,600 and from a second camera "PictureB.jpg"
with coordinates (x,y) 200,660 the file has to be formatted in the following way:
Point1 PictureA.JPG 100 600
Point1 PictureB.JPG 200 660
The "Import 3D" function
This tool allows the user to define control points by using 3D coordinates directly, without
detecting any control points in images. In order to exploit this tool the 3D coordinates
must have the same reference system as the workspace where the 3D model is being
processed. Afterwards control points can be defined for each coordinate as needed.
It is necessary to specify a reference object if users want to get the metric error
between their model/cloud and the 3D coordinates;
If 3D coordinates have to be considered as constraints (for instance to run a bundle
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adjustment optimization) it is recommended not to specify a reference object;

The "Export All" function
Just below the "Pick  Edit" button it is possible to access the control point (and
distances, defined in the "Measures" tab) export function.

From this window it is possible to export:
·

2D coordinates

Will create a *ControlPoints2D.txt file - defines the control points as 2D images
coordinates, as
"controlPoint1"
"controlPoint1"
"controlPoint2"
"controlPoint2"
·

"IMG_3319.jpg"
"IMG_3320.jpg"
"IMG_3319.jpg"
"IMG_3320.jpg"

4.33473658e+03
3.30352087e+03
3.01642756e+03
1.68567672e+03

2.24061730e+03
2.42468881e+03
3.16114630e+03
2.14786953e+03

3D Coordinates and 3D Constraints

Will create a *ControlPoints3D.txt\ .scr\ .dxf\ .ncn file - defines the control points as 3D
coordinates, as
"ControlPoint"
"Control Point #2"
·

8.18880729e-01
-5.64690812e-01

-5.14516149e-01
-5.65085273e-01

4.54143586e-01
1.09244112e+00

Distances

Will create a *ControlPoints3D.txt file - defines the distances as seen in the
measurements tab, as
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"Control Point #2"

"Control Point"

2.33824531e+01

The "Align model with 3D Constraints" function
Just below the "Export data" button it is possible to find the "Align model with 3D
constraints" function.

By defining at least three constraints (1) it is possible to scale the model using the
mentioned control points.
It is possible to either directly set constraints from a text file via the "Import constraints
from file" button or Load Camera GPS position from exif.
Note: every control point can be set as Check point (to measure the residuals),
Constraint (used in the bundle adjustment), or both by using the check boxes on the left
of each point. It's always a good idea to include some check points that are not set as
constraints.
*TIP*: What is the difference between Constraints and Check points?
Let's think about an aerial survey where you have both coordinates taken using the
drone's GPS system and coordinates taken on the ground with a total station for
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instance. Once you have placed your points in 3DF Zephyr, you can choose which points
must be the constraints, namely the points you are confident (of their accuracy) the most,
and which points will be taken into account as simple references to keep the error value
monitored.

In the "Coordinate Reference System"section, it is possible to change the input and
target reference system (2).

Clicking on "Select Projection CS" will open the "Projection Coordinate System"
window:

You can select the suitable coordinate system from the 3DF Zephyr database, or you
can import a new one from external source by clicking the "Import" button.
Once the correct reference system has been set, you may also perform the Bundle
Adjustment by checking the "perform bundle adjustment" option. This can be done by
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using a slider that will assign a confidence weight in the defined constraints and an
advanced mode option. Click the "Transform and Check Error" button (3) to start the
scaling process afterward.

3DF Zephyr can recognize those pictures taken by Real time Kinematic position (RTK)
drones and leverage RTK coordinates to scale the 3D model.
Please note that you can load RTK coordinates either by enabling the "import camera
position constraints" option in the new project wizard or by clicking the Align model
with 3D constraints button (GCP panel) once the camera orientation phase has been
completed. The following steps, besides the first one, apply to both workflows:
1) Click the Load cameras GPS positions from Exif button.
2) Set the "RTK" option from the drop-down menu in the Camera position accuracy
section (that option will change the accuracy to 30 centimeters). Optionally, you can
select the Custom option from the drop-down menu if you want to choose the accuracy
threshold according to your device specs.
3) Select the suitable Target reference system in the Coordinate reference system
section.
4) Click the Transform and check Error button.
5) Once the scaling process is done, you can check the Error Report.
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Measures panel
Quick measurements
You can quickly pick and measure directly in 3D space using the "quick measurement
tool".
This tool allows for measuring both the horizontal and slope distance, elevation and
inclination of a segment.
The following functions are not available in 3DF Zephyr Lite and 3DF Zephyr Free.
Control Points & Distances
Control distances can be defined as the distance between two control points , the
distance between a control point and a camera, or the distance between two cameras.
With 3DF Zephyr you can easily define control distances and even scale the world with
control distances.
The "Add control distance" function
To add a new control distance, click on the “Distance” Button (1). The “control point
selection window” (2) will pop up. From this window, pick the two control points needed
from the Control Point #1 selection menu and the Control Point #2 selection menu . Once
you click “OK”, the distance will be drawn as a green line (3) and rendered onto the
screen (in this case, 6.75459).
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The control distance (and the relative used control points) will also appear as a list on the
right side of the panel (4).

Scale world with control distances function
It is possible to scale the model using control distances:to do so, simply click on the
"Scale model with control distances" button: in the window that will pop up, simply set the
wanted distances as constraints. When completed, the residue error will be shown.
Import control distances from txt file
It is possible to import control distances directly from text file: every line of the text file
must be formatted as
"Control Point #2"

"Control Point"

2.18197

Measure mesh volume
It is possible to compute the mesh volume using the dedicated button. If the mesh is not
completely closed, all holes will be automatically filled and later shown with a red color it is possible to save that mesh as a separate workspace object.
You may also compute the volume of a dense point cloud rather than a mesh: by
selecting the desired dense point cloud as target for the computation, please note that a
mesh will be internally computed anyways.
Once you have selected the reference mesh from the menu, simply click the "Compute"
button.
Measure volume after projection
This tool allows calculation of the volume of a mesh or a point cloud by considering the
points distance and the position of a plane chosen by the user. Points under the plane
are not considered, while those above are projected on the plane's surface.
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This tool streamlines volume calculation of elements such as embankments and
excavations and it is handy for applications like 3D printing for instance.
The calculated mesh can be exported as a standard surface in the main formats provided
in 3DF Zephyr.

Volume after projection on a quarry: here the direction of the plane's normal is up

Hollow objects volume
This tool allows calculation of the volume of a cloud/mesh when the photographic survey
has been carried out from the inside of the acquired object itself, as in the case of a
room or a tank. Unlike the standard volume computation, this algorithm entails that the
normals of the objects point towards the inside. This also means that any other objects
cluttering the inner space will not be considered during this specific computation.
Volume between two sections
You can compute the volume between two sections: simply select the two reference
contour lines from the drawing elements panel, right click, and select "compute selection
volume"
Measure mesh area
Similar to the "measure mesh" function, clicking this button will compute the area of a
given mesh. Just select the mesh and click the "Compute" button.
Measure Angles
When at least three control points have been selected, you can compute the angle
between control points. The interface of the window that will appear will allow you to set
control points as A,B and C and then compute the angles between the vectors BA and
BC. A checkbox will allow you to change the output to radians or degrees.

Editing panel

51 / 135

3DF Zephyr

The editing panel allows to access the Selection/Editing tools, Filtering tools and the
drawing tools (this last function is not available in 3DF Zephyr Lite and 3DF Zephyr
Free).
·

Selection/editing tools

These functions allow to select elements from the workspaces so that they can be
edited/managed directly in 3DF Zephyr:
- the manual selection allows to select points (for sparse clouds and dense clouds) or
triangles (for mesh and textured mesh) through different selection modes (rectangle,
polygon, ellipse, lasso, box). By selecting the desired mode and the desired elements in
the 3D space, it will be possible to combine selected elements using the appropriate
action (add, remove and eventually by using pause to freely move in the workspace).
Those elements will be highlighted in red - once selected, it will be possible to manage
them using the appropriate commands in the "Edit" section.
- the selection by color will be applied similarly to both points and triangles: given a
certain color (that can be added manually or by picking it directly on the target object
from the 3D workspace) all points within a certain threshold will be selected.
- the selection by plane allows to select all elements above (or below) a certain user
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defined plane.
- the selection by points allow to select all those points (from sparse or dense clouds)
that are within the search parameters. The search parameters vary depending on the
selected algorithm between:
·
·
·

·

·

Visible cameras;
Reprojection error;
X84 Statistic: this algorithm selects those points whose density doesn't meet the X84
statistic criteria. It calculates which are the nearest points or not useful to remove
those too far from the correct solution, e.g. the points describing the sky;
Main plane fitting: this algorithm selects those points which lie well on a plane. It fits a
plane using the desired point cloud (decimated due to pc performance). It selects
those points whose distance from this fitted plane is under a certain threshold;
Cloth simulation: it selects those points that according to this algorithm "Cloth
Simulation Filter (see http://ramm.bnu.edu.cn/projects/CSF/) appear to be terrain.

- the selection by triangle, similarly to the previous point, allows to select all those
triangle within the search parameters depending on the selected algorithm between:
longest edge, area, connected components (this last one is very useful to quickly remove
all the "floating" noise from the reconstruction).
- the camera selection allows to select cameras directly in 3D space.

Once elements have been selected, it is possible to handle them using the editing tools:
- delete: deletes the select elements from the workspace
- invert: inverts the selection from the workspace
- cut: create a new element by removing the selected elements from the current element
- copy: create a new element by copying the elements from the current element.
- selection: allows to apply a filter only on the selected elements (smoothing, bilateral
filtering, retopology).
- confidence: allows to select (and eventually, remove) all the points below a certain
confidence threshold.

·

Volume of Interest

As of version 6.0, the Volume of Interest (VoI) is a new experimental feature designed to
aid users during the visualization and editing of huge datasets.
The user specifies a three-dimensional clipping region by visually editing it (this tool
works very similar to the bounding box editing tool).
The Volume of Interest tool is located in the Editing panel and you can click the Edit

53 / 135

3DF Zephyr

button (1) to enable it and open the "Edit rendering volume" window (2).

The clipped area will be highlighted by a pink and black waving layer. Once you are done
with editing the volume, simply click the OK button (3).

The point cloud/mesh will be trimmed in terms of rendering only, and the user will be free
to leverage other tools while the VoI is running (i.e., sections, contour lines or the
orthophoto generation can be performed).
Simply click the Reset button (4) to let Zephyr render the original 3D model.
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·

Filtering tools

These filters (that can be applied to point clouds and meshes) are also available in the
Tools menu. You can learn more about these function in the point cloud filters chapter
and in the mesh filters chapter.

·

Drawing elements tools

55 / 135

3DF Zephyr

With this tool it is possible to create drawing elements directly on the 3D model, which
then can be exported into .DXF or .SHP.
To create a new drawing element, simply click the "+" button - the new element will be
automatically added to the "Drawing Elements" section in the Project tab.
Once an element has been created, the drop-down menu to select the current drawing
element will be enabled (in this case, it will be shown the only drawing element available,
the "Drawing Element" right under the "Create new element" button). This allows you to
select and edit previously created drawing elements.
When the drawing element has been selected, it is possible to navigate the scene to the
desired position (eventually by making use of the "Orthographic mode" checkbox).
When ready, it is possible to select the middle points that will define the shape of the
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drawn element, by picking them directly on the mesh using the "Pick" button. You may
also use the "continuous mode" checkbox that won't ask for many clicks (each for every
middle point) but instead it will draw the line as long as the left click is kept pressed and
the cursor is on top of the mesh.
Press "ESC" to exit the drawing mode.
It is possible to change the color of one (or more) drawing elements by selecting the
desired elements from the "Drawing Elements" section in the Project tab by right-clicking
on the selection and then selecting "Change color selected"

It is also possible to generate a polyline from control points: simply right click a
control point and select "Make a polyline". You will be then be able to select the points
of the polyline.
Similarly, you can also create surfaces from this very same tool, and again, you can
create them also by using control points.

3DF Zephyr also allows to automatically generate blueprints. This functionality works
better with laser scanner imported point clouds but can be used also with
photogrammetry-generated point clouds.
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Once the user has selected the appropriate mode (interiors vs exteriors) and confirmed
the automatically detected floor and ceiling planes, 3DF Zephyr will automatically
compute and save the blueprints (polylines and surfaces).

Bundle adjustment
What is the bundle adjustment?
The bundle adjustment is a non-linear minimization procedure that adjust points and
cameras by minimizing the reprojection error of points. It’s performed at the end of each
merge and a final bundle adjustment with all points and cameras is always performed at
the end of the structure from motion procedure.
3DF Zephyr (except for 3DF Zephyr Lite and 3DF Zephyr Free) allows running of
additional bundle adjustment steps manually by feeding 2D or 3D constraints.
Since the bundle adjustment works on the camera internal and external parameters, keep
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in mind that only the sparse point cloud will be affected by the bundle adjustment. Any
existing element such as dense clouds or meshes that are already in the workspace will
not be changed at all. It is strongly advised to run the bundle adjustment after the sparse
point cloud until the camera orientation looks right, before moving to the dense point
cloud generation.
Zephyr offers an easy to use slider to control the bundle adjustment process, in which
you can define the confidence in the constraints. It’s worth noticing that the more
confidence you put into the manual constraint, the less confidence will be made by
Zephyr in its automatically generated points.
·

Running the “Workspace > Optimize Camera Parameters” menu option

This option only uses the 2D control points as constraints for the bundle adjustment. This
is weaker than using 3D constraints, however if you lack any 3D information (such as
ground control points) this is your only option.
·

Running the “Align model with 3D Constraints” option

Similarly, you can run an additional bundle adjustment when scaling the model with
control points. Having additional 3D information will help Zephyr to drive the
reconstruction towards the correct solution.
The minimum number of control points set as constraints to run the bundle adjustment is
3. However ,a higher number is advised, especially when accuracy is important.
You should only increase the bundle adjustment slider value as you increase the number
of control points defined in the workspace accordingly, otherwise the final geometry will
be closer to the defined constraints only in proximity of the aforementioned constraint
points, thus registering high deviation in all the automatically generated points.
Typical usage is when the reconstruction shows an unexpected “rounded” effect due to
drifting after the sparse point cloud has been generated, you should try running this type
of additional bundle adjustment. If the employed camera/s has/have a very high radial
distortion (i.e. fisheye lenses) make sure that “adjust radial distortion” is enabled.
When doing this, again, make sure to use a congruous amount of control points. It’s also
suggested that you use some control points as constraints, as well as some control
points only as control so that you have a way to verify that the solution has been
improved (the residual value should obviously get lower).
Setting the confidence of the constraints to 99% (or similar) is generally a bad idea.

Layers and multispectral images
3DF Zephyr supports multi layers. You can select a main layer (which will be used for
Structure from Motion) and have secondary layers that can be switched when needed.
Multi layers are often used with multispectral imagery data (see also the photometric
calibration chapter if this is your case) or with fixed shooting rig (for example to handle
two layers, one with projected patterns and one with RGB images).
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Both cases are handled the same way in Zephyr: when images have a suffix (e.g.
myfile000_layerone.jpg and myfile000_layertwo.jpg) that may seem like a layer and are
added to the project Wizard, Zephyr will ask if you wish to create a multi-layer project.

If you answer yes, Zephyr will automatically split the files into an appropriate numebr of
layers according to the suffix. If you say no, you will still be able to create layers by rightclicking and selecting "add layer".

You can select the main layer (which will be used for the structure from motion phase) by
right clicking and selecting "set as main". Once layers have been set up, you can
proceed normally.
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The "File" menu
The "File" menu manages the opening and saving of Zephyr project files, as well as few
other functions.
In addition to the self-explanatory open/save, other functions are:
Load Model
This function allows loading of a model into Zephyr to use it as a viewer. Loading a
model will force the current workspace to be closed. The following file formats are
supported:
·
·
·
·
·
·
·
·
·
·
·
·
·

ply
las
ptx
obj
e57
collada (xml, dae)
pts
xyz
rcp
fls, fws (Faro)
zfs (Z+F)
dp (Dot Product)
rdbx (RIEGL)

Please note that the Faro, RIEGL, DotProduct and Z+F require the installation of
additional plugins available for free at the URL http://www.3dflow.net/native-laserscanner-support-plugin-3df-zephyr-download/
Load 3DK file
3DK files are Zephyr compatible projects made with the 3Dflow's SDK FlowEngine
(https://www.3dflowengine.com).
Open, Save and Load a project

Each project created with Zephyr is saved as .zep format.
Each workspace also includes the photographs used for the 3D reconstruction, therefore
it is possible to open, send and edit the path of .zep files irrespective of the location of
the image files. Nevertheless it will not be possible to start one of the four phases of 3D
reconstruction or make changes involving photograph usage.
Click on File > Open or Open Recent to open a .zep project, or click on Save or Save
As to save your work.
If you have a command-line reconstruction made with 3DF Samantha, the Structure from
Motion algorithm, you can import that by selecting File > Load from 3DF Samantha.
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·

Load .psz files

This function is not available in 3DF Zephyr Lite and 3DF Zephyr Free.
Within Zephyr you can be load psz project by clicking on File > Load from .psz file.
Cameras, sparse point cloud and mesh of psz project are imported In Zephyr and you
can now start some 3D reconstruction phases such as the dense point cloud or texture
generation.

·

Load pictures with known camera parameters

This function is not available in 3DF Zephyr Lite and 3DF Zephyr Free.
In Zephyr you can manually import all the parameters of a camera before starting the
cameras orientation phase; cameras will be calibrated without being adjusted by the
Structure from Motion algorithm.
To load the parameters just click on File> Load images with known camera
parameters.
It is also possible to use .XMP files to import a specific camera configuration and skip
the sparse 3D reconstruction: this is the preferred workflow for fixed rigs.

The "Workflow" menu
The workflow menu allows users to undertake major actions within the 3D reconstruction
workflow, such as starting a new project, completing a reconstruction step or adding
photos.
The "New Project" function
By clicking "New project" the current workspace will be cleared and the new project
wizard will appear, as shown earlier in the "Starting a new project" chapter.
The "3D Model Generation" function
Starts a new dense point cloud wizard and, after that, a new mesh generation wizard.
The "Textured mesh extraction" function
Starts a new texture mesh extraction wizard. See the "Extracting a surface" chapter as
reference. More than one textured mesh can co-exist in the same workspace.
The "Orthophoto from sparse point cloud" function
Starts a new orthophoto creation wizard from sparse point cloud called orthomosaic.
The "Orthophoto from dense point cloud" function
Starts a new orthophoto creation wizard from dense point cloud called orthomosaic.
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The "True orthophoto from Mesh" function
Starts a new orthophoto creation wizard from Mesh called "True Orthophoto".
The "Quick Project" function
This dialog allows to quickly start a new project with a compact interface that allows to
skip many of the dialogs shown in the classic workflow wizard.
The "Add photos" function
This process allows addition of photos to the current workspace. The photos have to be
taken with one of the cameras already used in the original workspace. The "Add photos"
dialog is similar to the "New project" wizard, so you simply have to add photos by
browsing or by drag and dropping them. After the new photos have been selected, the
following dialog will appear:

All that is required to do, is to simply select at least one camera on the left panel (by leftclicking it) which is near to the photos that you want to add. If the photos can be added
to the workspace correctly, you will see them in the "Cameras" section and the "Sparse
point cloud" will be replaced with the new one, computed using the new cameras in the
workspace. Any other workspace element (such as dense point clouds and meshes)
won't be affected automatically by this action.
The "Add photo with control points" function
Note: at least three control points have to be placed on the 3D model before running this
function.
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Choose the pictures you want to add to your current dataset. Into the new window you
are requested to find the control points you have previously placed on the 3D model as
well as to provide the tool with a camera calibration file of that specific picture if it has
been captured with different camera settings.
You can reach the same function by right-clicking on a non-oriented picture inside the
Project panel and selecting the "Orient selected from control points" option.
The "Advanced" menu

The advanced menu offers some extra feature :
The "Dense Point Cloud generation" function
Starts a new dense point cloud generation wizard. See the "Extracting a dense point
cloud" chapter as reference. More than one dense point cloud can co-exist in the same
workspace.
The "Mesh extraction" function
Starts a new mesh extraction wizard. See the "Extracting a surface" chapter as
reference. More than one mesh can co-exist in the same workspace.
The "Generate and export enhanced mesh" function
This function allows to regenerate a mesh (or textured mesh) while arbitrarily densifying
the polycount and eventually by intensifying high frequencies details - please note these
are fake details as they are not generated with a photogrammetric process. This is a
niche feature developed for very specific workflows.
The generate and exports normal maps function
This function opens the window that allows the generation and export of normal maps
and displacement maps. You need a high poly mesh and a low poly textured mesh in the
workspace in order to bake any of these maps.
Generate and Export planar texture maps

It's possible to generate and export planar texture maps of a textured mesh in 3DF
Zephyr.
You should select a planar parts of the mesh with the Selections tools and use the Cut
tool in the editing tab.
Open the "Generate and Export Planar Texture Maps" window under the Workflow
menu.
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In the Object section choose the selected planar part of the textured mesh. A blue
square plan detector will be shown in the workspace window. It's possible to set
rotation, position, size, and the axes of the blue square plan detector.
If there are control points present on the mesh, you can use them to align the blue plan
detector on the target mesh part with Pick First Point and Pick Second Point button.
The Max texture size and Texture format can be set below the previous options.
The Pixel-level enhance filter densifies the mesh to have one triangle per pixel of the
final map and applies the enhancement filter (similar to photoconsistency).
The Map type can be used to set coordinates system (Tangent space, Object space)
to export normal maps.
In the export path space, you can set the folder for saving the exported textures.
You can decide which part of the texture can be exported (color maps, normal maps, and
displacement maps) or add the generated texture in the workspace.

Orthophoto generation
Since version 4.2, all the orthophoto generation functions have been unified in one single,
better and easier to use interface. Orhotphotos are now embedded in the .zep file which
means that their generation has now been moved to the Workflow menu.
From this menu it's possible to access the Orthophoto generation functions.
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These functions are note available in 3DF Zephyr Lite and 3DF Zephyr Free.
These functions allow selection of the generation method either via a reference axis (1),
via control points (2) (by defining at least three of them), or by using the current view in
the 3D viewport (3).

These functions expose a preview of the orthophoto directly in the scene as soon as you
click "Next" (please note that the preview may be hidden below the orthophoto
generation window).
3DF Zephyr allows orthophoto generation from sparse point clouds and dense point
cloud, as well as true orthophoto generation from mesh. It's better to generate a true
orthophoto for better results.
The orthophoto/true orthophoto generation is controlled by the following window:
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3DF Zephyr will show the target object (4) and immediately below it the current
coordinate system. Remember you can change the current coordinate reference system
in the Ground Control Points tab.
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You can then control from this window the position (5) export (6) and advanced (7)
settings (and eventually multispectral composition)
·

Position Settings (5)

You can either define width and height of the orthophoto or set the desired Ground
Sample Distance and let Zephyr calculate the other parameter(s) for you. You can also
eventually define the number of vertical and horizontal tiles you wish to split the
orthophoto into (fundamental for very big orthophoto or for computers with a low amount
of memory).
You can delimit the orthophoto generation area (considering the top right corner and
bottom left corner) either via a manually defined "rubber band" box or using control points
(press "ESC" if you accidentally enter the rubber band mode selection and wish to exit).
The closest rotation axis can be also defined from control points.
·

Export Settings (6)

You can select the final "product" of the computation from this section: Orthophoto, KML,
Autocad Script file ( a .scr file that will automatically load the orthophoto within Autocad,
with the correct scale settings set in Zephyr - all you need to do is simply drag and drop
the scr file inside the AutoCAD session), PDF and World file, by simply checking the right
checkbox. Moreover, with the 4.5 version of 3DF Zephyr, there is no limit in exporting the
orthophoto, which can now be saved as a unique BigTiff file.
Two additional checkboxes are available and those allow the generation of the DSM file
(by selecting the elevation axis) and the DTM file (automatically generated according to
the scene type). If the DSM/DTM file is generated, Zephyr will automatically open its
DEM viewer utility when the process has finished.
·

Advanced Settings (7)

These settings give you a higher control over the process and are divided into "Position
Parameters" and "Generation Parameters".
With the position parameters, it is possible to define directly the U0,V0 and U1,V1
coordinates as well as minimum and maximum depth (useful if you want to ignore "slices"
of the reconstruction in your orthophoto).
The generation parameters allow you to choose whether to use the color balancing and
the smart crop and fill borders options. Additionally you can set the speed up level and
the blending method that you prefer, plus the ability to ignore cameras during the
generation process.
Finally, the "Export options" in this subsection allow to draw the control points and grid on
the orthophoto if desired.
When ready, simply click "Generate Orthophoto" (8) and select the file destination in
order to proceed.
Note : From 3DF Zephyr 4.5 you can export the orthophoto as Big TIFF format.
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Multispectral orthophoto composition

If more bands (layers) are available in the workspace, the following subsection will also
be shown in the orthophoto generation wizard.

You can select the desired bands in outoput and eventually create your own composition
by clicking the "Add band" button and using the following interface:

You may also click the "Load transform" button to access previously saved data (e.g.
NDVI) or use the save button to save your user defined formula.

The "Import" menu
The "Import" menu allows you to import different data into the workspace, for example
point clouds or meshes. Importing a model into a workspace will not cause the
workspace to be closed, so that you may combine different sources.
You may:
·

Import a model (point cloud or mesh) from an external source. Any imported model at
this point will be unstructured, but it can be made structured so that the visibility
information can be used. Multi-ICP alignment for laser scanned point cloud is
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available for this purpose.
·

Import a mesh with custom UVs in order to regenerate a texture with said UVs (the
mesh can be composed by triangles and/or quads)

·

Import a whole other Zephyr workspace in order to merge it with the currently
opened one.

·

Import drawing elements (DXF and XML, not available in 3DF Zephyr Lite and 3DF
Zephyr Free)

Import a model (point cloud or mesh)

These functions are not available in 3DF Zephyr Lite and 3DF Zephyr Free.
Zephyr can import all the file types supported for visualization.

To start the tool just click on Import > Import model (both point clouds and meshes) in
the menu bar. Now click on Import mesh from file button. Time taken to import depends
on the size of the mesh file.
Once the file is loaded you can click on Import in the workspace button.

Point cloud file formats available for import:
.ply

.fls

.las

.fws

.ptx

.zfs

.pts

.rdb

.xyz

.rdbx

.txt

.dp

.e57

.x3a

.rcp

.laz

.xml

Mesh file formats available for import:
.obj
.ply
.dae
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.osgb
.ive
.fbx
.xml
Import a mesh with UV map

This tool allows to import an external mesh with known UV map into the current
workspace and apply a texture on it.
Before using this tool you need to make a 3D reconstruction, usually completing at least
the mesh generation phase. In this way you can add the color information to the mesh
you want to import.
Tip: the mesh you are importing and the one generated with Zephyr must have the same
reference system. In a nutshell you have to make the same procedure as in SRT
transformation alignment tool related to point cloud import.
Merge projects

These functions are not available in 3DF Zephyr Lite and 3DF Zephyr Free.
In 3DF Zephyr you can merge two or more .zep projects related to the same scene or
subject. Simply click on Import menu and select Import and Merge another
workspace option.
To optimize the procedure it is recommended to generate just the sparse point cloud
into the projects involved before proceeding with the merge. Once this is completed it will
be possible to start the following steps of 3D reconstruction.
However, it is a perfectly valid workflow to merge two different projects with all kinds of
other elements: the wizard will ask you which other elements (any dense cloud, mesh or
textured mesh) will be imported into the current workspace.
The photographs of the projects have to share a common area so you can proceed to
the merge by means of:
·

Control points: after clicking on Import > Import and merge another workspace
you will see the Import window. It is necessary to place at least three control points
on each point cloud of the projects before running this procedure. Control points must
have the same position and the same name to allow Zephyr to find matches between
them and proceed to the merge. It is recommended to keep the Compute Bundle
Adjustment option active so as to further optimize the merge process.

·

Nearby cameras: click on Import > Import and merge another workspace to open
the Import window where you just select the project you want to merge and click the
Import button. If no control points are placed in the projects Zephyr will automatically
select Use the nearby cameras option.
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·

Same Reference systems (direct merge): is the third option which let users merge
different projects having the same reference system (local or geographic).

In the image above you can see the pictures of current project work on the left side while
the images to be merged are shown on the right side of the window. Note that the
thumbnails of images on the right side are displayed in black and white as long as the
user selects at least one photograph from the group on the left.
First of all you need to select at least one picture in the list on the left, then you have to
select at least one picture in the list on the right. The most proper pictures to be
selected focus on a common area of the captured subject or scene.
Import drawing elements

This tool allows to import CAD elements (available file formats: .xml, .dxf) in 3DF Zephyr.
Please note that the drawing elements you are importing and the point cloud/ mesh
generated in Zephyr must have the same reference system in order to be correctly
overlaid on each other.

The "Export" menu
The export menu allows export of different elements from the workspace as standalone
files (for example, an obj file) or to other services (for example, direct upload to
YouTube).
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The "Export cameras and points" function
This function is not available in 3DF Zephyr Lite and 3DF Zephyr Free.
This function allows export of cameras (internal and external parameters for each
camera - one text file for the externals and one text file for the internals) giving different
options to the advanced user, such as the option to export the projection matrices for
OpenGL, the points visibility and the option to export the sparse point cloud (in PLY
format) and to generate the undistorted images.
The "export dense point cloud" function
This function is not available in 3DF Zephyr Lite and 3DF Zephyr Free.
This function allows export of the generated dense point clouds into different file formats.
The first option in the export dialog allows selection of the desired dense point cloud,
since more than one dense point cloud can coexist in the same workspace.
The "Export format" option allows to select the desired export format - it is possible to
export directly into .ply, .pts, .ptx, .xyz, .txt, .las, .e57, .ncn, .laz, .rcp and to the 3D
visualization web service Sketchfab. By selecting certain formats, some advanced
options may or may not be enabled
The "Export colors" option (if selected and for the supported formats) allows export of
the point colors.
The "Export normals" option (if selected and for the supported formats) allows export of
the normals.
The "Use binary encoding" option (if selected and for the supported formats) allows
export in binary mode (or in text mode if not selected).
The "Decimate" option (if selected) allows automatic decimation of the dense point cloud
point number up to the desired value (as defined by the Max point cloud option).
The "Local rendering reference system" option (if selected and for the supported
formats) allows export by using the local rendering reference system.
The "Export mesh" function
This function allows export of the generated meshes in different file formats.
The first option in the export dialog allows selection of the desired mesh, since more
meshes can coexist in the same workspace.
3DF Zephyr Lite allows export to .ply, .stl, .obj/mtl and and to the 3D visualization web
service Sketchfab. By selecting certain formats, some advanced options may or may not
be enabled.
3DF Zephyr allows to export (in addition to the formats exported by 3DF Zephyr Lite)
also to the .fbx, pdf3D, Universal3D, Collada (.dae), .3mf and .dxf file formats. Please
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note that the fbx format also allows to export the camera positions.
The "Export normals" option (if selected and for the supported formats) allows to export
the normals
The "Use binary encoding" option (if selected and for the supported formats) allows to
export in binary mode (or in text mode if not selected)
The "Export cameras" option (only for 3DF Zephyr, if selected and for the supported
formats) allows to save the camera positions.
The "remesh before exporting" option (if selected) allows execution of the remeshing
algorithm, which will generate a new mesh with a vertex count as higher as the number
defined by the user.
The "Add comment" option (if selected and for the supported formats) allows to addition
of a text comment as file metadata.
The "Export textured mesh" function
This function allows export of the generated textured meshes in different file formats.
The first option in the export dialog allows selection of the desired textured mesh, since
more textured meshes can coexist in the same workspace.
3DF Zephyr Free can only export textured meshes in a limited number of formats as well
as 3D visualization on Sketchfab.
3DF Zephyr Lite allows export to .ply, .obj/mtl and and to the 3D visualization web
service Sketchfab. By selecting certain formats, some advanced options may or may not
be enabled.
3DF Zephyr also allows to export (in addition to the formats exported by 3DF Zephyr lite)
to .fbx, pdf3d, Universal3D and Collada file formats. Please note that the fbx format also
allows export of the camera positions.
The "Export normals" option (if selected and for the supported formats) allows export of
the normals.
The "Use binary encoding" option (if selected and for the supported formats) allows
export in binary mode (or in text mode if not selected).
The "Export cameras" option (not available in 3DF Zephyr Lite and 3DF Zephyr Free), if
selected and for the supported formats, allows saving of the camera positions.
The "Add comment" option (if selected and for the supported formats) allows addition of
a text comment as file metadata.
This dialog also allows you to choose, when available, the texture export format (PNG,
JPG, EXR and TIFF32) as well as select the maximum size of the texture. If you wish to
rescale the texture, please note that it's a simple rescaling operation, which does not add
detail. You may rescale to a fixed power of two size or automatically compute the
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nearest power of two value.
The "Export LOD Mesh" function
This function is not available in 3DF Zephyr Lite and 3DF Zephyr Free.
The mesh will be re-generated and split into a certain number of tiles in order to preserve
level of detail over huge meshes. Currently, only the KMZ file format is available.
The "Export control points" function
This function is not available in 3DF Zephyr Lite and 3DF Zephyr Free.
This button opens the same dialog that the "Export data" button shows from the "Control
point" panel.
The "Export workspace" function
This function is not available in 3DF Zephyr Lite and 3DF Zephyr Free.
This function allows export of the workspace to .ply/text files.
The "Export processing report" function
This function is not available in 3DF Zephyr Lite and 3DF Zephyr Free.
This function will create a pdf report about the current workspace. The report will contain
information about the workspace, from the sparse point cloud to the textured mesh, with
a technical summary and statistics.
The "Export current view as PDF"
This function allows creation of a screenshot of the workspace current view, as a PDF
file.
The "Take screenshot" function
Like the "Export current view as PDF" function, this function allows creation of a
screenshot of the current view, as an image file. Some additional options are available,
such as the possibility to have a transparent background.

The "Edit" menu
From the "Edit" menu it is possible to quickly access the classic "Undo" (CTRL+Z) and
"Redo" (CTRL+Y) actions.
Not all actions in Zephyr support undo/redo.
The command history can be seen from the "History" panel.

The "Scene" menu
This menu allows the user to manage how the subject is rendered and how the bounding
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box is defined in the scene.
Most of these functions have a quick access button on the main toolbar.
Camera management via the "Camera" menu
Zephyr allows navigation of the scene in three different ways:
·

·
·

Orbit: in order to navigate the scene in "orbit" mode the mouse cursor has to be on
scene: keep the left mouse button pressed and move the mouse to orbit around the
subject. To zoom in or out, keep pressed the left shift button and move the mouse
forward/backwards. The pivot is centered as the center of the bounding box.
Orbit with pivot: similar to orbit; however, the pivot will be moved where the mouse
cursor is at the time of the left-click button press.
Free look: "first person shooter" view where the movement is applied via the WASD
buttons (W forward, S backwards, A left, D right) and Q/E (up,down).

The "Orthographic projection" camera mode can be toggled via the dedicated check-box.
Finally, there are buttons that allow the user to move quickly into a predefined position
with respect to the subject (move left, move up, etc.) and a reset camera button.
Rendering management
The rendering settings can be changed by modifying the following settings:
Turn light on/off: toggles the lighting applied to the scene
Show only sparse point cloud: changes the current active workspace object to the
sparse point cloud.
Show only dense point cloud: changes the current active workspace object to the dense
point cloud.
Show only mesh: changes the current active workspace object to the mesh.
Show only textured mesh: changes the current active workspace object to the textured
mesh.
Enable/Disable wireframe: toggles the wireframe visualization
Enable/Disable colors : if the lighting is enabled, this can be used to disable the mesh
color for an easier mesh inspection. Obviously, if the lighting is turned off this option
won't be enabled as well.
Enable/Disable culling: toggles triangle culling
Enable/Disable volume: shows the computed mesh volume
Edit bounding box
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You can enable the bounding box widget from this submenu.

The "Tools" Menu
Tools that directly impact the workspace are grouped under the "Tools" menu.
Tools - Workspace

The Workspace menu allows the user to run tools dedicated to the management of the
3D objects and to the pictures used in the 3D reconstruction:
·

Scale - Rotate - Translate world: allows the user to scale/rotate/translate the 3D
models (clouds and meshes)

·

Define the up vector manually : allows to access to "define up vector" window and
from here to following tools :

o Define the up vector by selecting two points: allows drawing of a segment
directly on the 3D model to be aligned with the Z axis (basically, the drawing
must be done on an element of the 3D model that is actually on the up vector
in the real world, such as a wall in a building)
o Define the up vector by selecting the ground plane: allows drawing of a
triangle (a plane) from which the Z axis will be computed (the plane must be
done on an element of the 3D model that is actually on the horizontal axis in
the real world, such as the ground). After picking the second point in the plane,
two arrows will be rendered on the screen, one that will show the Z axis (blue
arrow) and the normal direction of the plane (Red arrow). In order to correctly
align the z axis, the two arrows must match.
o Define the plane vectors by selecting two axes: allows selection of the
plane vectors by selecting the two corresponding axes. Simply left-click the
origin point and then the second point that will define the first axis. After that,
select the second point (from the selected origin) that will define the second
axis.
·

Change workspace images: this tool is very useful when working with thermal or
NIR (Near Infrared) images: after the 3D reconstruction has been completed using
classic RGB images from a normal camera, you can swap the corresponding
NIR/thermal image and everything will behave exactly as the sparse point cloud was
made with those images. Although this is still a valid workflow - and the only one up to
Zephyr 3.700 - you should now use the multilayer workflow for this case.
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·

Change Masks: allows changing of the masks used for the current dataset

·

Camera Stats: shows information about the mean reprojection error and the number
of points viewed by each camera in the sparse point cloud.

·

Matches viewer: opens the match viewer interface. Simply select an image on the
left panel by left-clicking it and similarly an image on the right panel. After clicking
"next", keypoints and matches will be shown with a line between the two images.
Simply click "back" and repeat the process to see matches from different images.

·

Camera Links: they show the strength of the matches between the cameras during
the orientation phase. A series of lines which link the cameras will be shown in the
workspace according to a matching threshold defined by the user, while their degree
of intensity is indicated through a color map.

78 / 135

3DF Zephyr

·

Camera GPS Coordinates: shows a preview of the GPS coordinates via
OpenStreetMap.

·

Enable/Disable confidence: allows the user to see/hide information about the dense
point cloud confidence.

·

Optimize camera parameters: this tool allows running a further bundle adjustment,
in order to improve the accuracy of the Structure from Motion algorithm. It is
advisable to run this tool before running the Multi View Stereo phase (dense point
cloud extraction).

Tip: a typical case in which the bundle adjustment step is required is when the first
camera orientation step has completed with a mean reprojection error value above 1:
after placing at least three control points from the images it is possible to run the
"optimize camera parameters" step, giving much more weight to the defined constraints.
·

Optimize camera parameters using terrain assumption (experimental)

This tool allows the user to run the bundle adjustment, however by assuming a terrain.
This is very useful when the structure from motion suffers from error drifting and causes
the reconstruction to look "bent". By using this tool, Zephyr will guide the reconstruction
using a planar assumption.
·

Manage camera layers: manage multi-layers for multi-layers datasets.

Tools - Selection

The "Select" menù allows the user to apply certain functions to the workspace elements most of these commands have a direct quick button on the main toolbar. These tools
have the same effect as those in the editing panel.
Select all: selects all the currently active subject in the workspace - triangles for
meshes, points for clouds. The selected part will be highlighted by a red color.
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Invert selection: invert the previously done selection. The selected part will be
highlighted by a red color.
Enable/Disable point selection mode: allows selection of a part of the currently active
object in the workspace - the selection is made by including all the points contained within
a dragged rectangle in the workspace (keeping the left-click button pressed) - when the
click is released, the selection will be done. The selected part will be highlighted with a
red color.
Enable/Disable polygon selection mode: allows selection of a part of the currently
active object in the workspace - the selection is made by including all the points
contained withing a polygon defined by clicking and connecting the polygon points in the
workspace - when the polygon is closed, the selected part will be highlighted by a red
color.
Delete selected items: deletes those elements currently selected (highlighted in red)
from the currently active object.
Select by color: selects (on dense point clouds) all the points of a given color (within a
given threshold).
Select by plane: selects a part of the currently active subject - the selection is done by
placing a plane that will "cut" the subject - all points above that plane will be selected.
The selected part will be highlighted with a red color.
New object via copy: creates a new object in the workspace, by making a copy of the
current selection.
New object via cut: creates a new object in the workspace, by cutting the selected
object. The inverse of the selection will become the origin object.
Tools - Point Cloud Filters

From this menu it's possible to apply the selected mesh filter to a dense point cloud in
the workspace.
Decimation: select the desired point cloud with the dropdown menu and the number of
desired points. The point cloud will be regenerated decimating the point count to the
maximum specified value.
More specifically, it is possible to decimate the desired point cloud using these different
methods:
- Maximum points count;
- Maximum points count with octree (the octree is a data structure which guarantees a
more homogeneous distribution of the decimated points);
- Average point distance;
- Octree size.
Densification: select the desired point cloud with the dropdown menu and the number of
desired points. The point cloud will be regenerated densifying the point count to the
maximum specified value. Only structured point clouds can be densified.
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Project on regular grid: with this filter it's possible to use a regular grid as a projection
for the dense point cloud, so that points are at a regular distance. You may define the
grid spacing as well as the grid research value for the grid generation. This tool is
especially useful for aerial datasets in topography.
Update colors: This filter can be used either to recompute colors from images (useful
when you are changing the workspace images) or by elevation (useful to colorize a
laserscan cloud for example). If you choose the latter, a list of available colormaps will
be shown for selection.

Tools - Mesh Filters

From this menu it's possible to apply the selected mesh filter to a mesh in the
workspace.
Decimation: allows selecting the referred mesh from the drop-down menu and setting
the number of corresponding vertices. The mesh will be regenerated by decimating the
number of vertices with the specified maximum value. You can ask the software to:
·

Preserve the boundaries: with this option, the vertices borders are never
decimated. Therefore, it will allow having an edge equal to the starting mesh; the
disadvantage is that the border remains much denser at
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the inner part's expense, resulting in fewer points and less detail.
Constraint distances from the input mesh: the decimation process uses an extra
constraint for selecting the vertices to be decimated, which is based on the distance
from the starting mesh.
You can either apply the filter to the mesh you have selected or clone it and filter the
copied mesh.
·

Densification: select the reference mesh with the drop-down menu and the desired
number of vertices. The mesh will be regenerated by densifying the number of vertices
with the specified maximum value.
You can either apply the filter to the mesh you have selected or clone it and filter the
mesh copy.
Laplacian smoother: reduces the mesh noise and does not keep sharp edges. The
more iterations are inserted, the more smooth the mesh will be. This filter is suitable for
non-edged subjects (e.g., human body datasets).
Bilateral smoother: the filter allows to smooth selected mesh with the appropriate dropdown menu, and it reduces noise by improving and emphasizing edges where it is
possible. This filter is suitable for architecture and construction scenarios.

Photoconsistency: this is a kind of filter that, based on photos, optimizes the surface of
the model to make it as much consistent as possible with the starting images, through a
minimization process, where at each iteration, the surface is modified in such a way as to
reduce the error of reprojection of one image on the other. This allows obtaining a much
more detailed rendering of the surface, thus increasing its accuracy.
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Here below, a detailed analysis of how to change these settings; in brackets ( ), you will
find the default values:
·

Image resolution (50): controls the image’s scale resolution used internally by the
photoconsistency algorithm. If you already have suitable initial geometry, it is
reasonable to run the photoconsistency with a high resolution (50% – 75% ). If the
input is of poor quality, it is advised to leave a low resolution (25%).

·

Hierarchical subdivision (1): if this value is greater than zero, the photoconsistency
algorithm will be sequentially applied more times, automatically adjusting the image
resolution and the iteration number. This means that the same results can be obtained
by running the same algorithm multiple times with different and appropriate settings.

·

Reprojection area (20): controls the size that every triangle will try to obtain at the
end of the photoconsistency process. Given a triangle, its final reprojection area (in
pixels) to the nearest camera will tend to get near to the specified value. Lowering
this value will make a denser mesh: the final mesh will then have a variable level of
detail, with a higher vertex point cloud corresponding to those areas viewed by nearer
cameras. In most cases, the default value will work well; in case you are dealing with
a mesh that is already very good (for example, one that has already finished a
photoconsistency step). This parameter can be lowered to get more detail; instead, it
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can be raised in very noisy meshes and low-quality images.
·

Enhance filter (0): it is a post-processing method that can generate “fake details” by
increasing the number of mesh triangles. Depending on the result you want to obtain
and the photo’s quality, you need to carefully adjust the slider to avoid creating
additional noise instead of additional details.

·

Edge filter (0): this parameter is used to emphasize edges; the more the mesh is
angular (buildings, objects, etc.), the more you can increase this value. Usually, it can
be kept at a value of 0.5.

·

Update colors: calculate vertex colors according to cameras. It recalculates the
colors each time after making the photoconsistency. The flag can disable for the test,
and the colors can be recalculated later.

Retopology: This filter allows you to optimize the mesh topology. Triangles will be
simplified and Zephyr will try to generate larger triangles where possible. The greater the
optimization factor, the larger the size of the generated triangles. Please, note the filter
may cause a loss of mesh detail, especially where there are geometries with welldefined edges.
Fill Holes Selective or WaterTight: it allows to automatically fill and close holes in the
meshes. There are two modes are available:
·
·

WaterTight mode: allows automatically filling all the holes at once.
Selective mode: allows filling the holes manually in the selection window. You can
select a specific hole by:

- Number: choosing it directly in the 3D workspace with the pick hole button, or the
corresponding number (the hole will be highlighted with an outline in the workspace).
- Size: defining the size threshold using the dedicated slider.
The color of the triangles that will close the hole will most likely be wrong when the
missing visibility of the point from the camera will behave in a degenerated way (and it is
impossible to identify the color of something that is not seen by any picture).
The Selective mode allows you to close single holes faster, but it may not work for
complex cases, which we recommend using the WaterTight mode.
Cut with plane: this function allows you to cut the mesh sharply with a plane,
regenerating the triangles on the edge where cut.
Cut with bounding box: by changing the bounding box’s size created by the mesh, it
can be adjusted to cut unnecessary parts and exclude them outside the bounding box.
Update colors: this filter allows re-computing mesh colors:
·

From images: (e.g., to change the workspace pictures if you are dealing with
multispectral imagery).
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·

By elevation: it updates the colors according to the points’ elevation. A list of color
maps will allow you to pick among several color palettes.

·

By normals: using normal maps from the dataset images.

·

Uniform: choosing one specific color from a color palette.

·

By curvature: different sets of colors can be applied according to the local
geometry, which means the color varies depending on whether the area is flat,
angular, or curved.

Filter Selection: allows applying a filter of your choice (Laplacian, Bilateral, Retopology,
etc.) to a selection of triangles. Select the triangles first (using any tool, such as lasso or
area selection of triangles) and then run the selection filter on those triangles.
Ground Extraction: allows the automatic extraction of the terrain from a mesh to create
a 3D Digital Terrain Model (DTM) and eliminate everything above, such as trees and
houses. Users can select the mesh and set the following parameters:
·

Scene: suggests filtering the type of scenario that has been reconstructed in 3D.

·

Resolution: refers to the grid size of cloth that is used to cover the terrain. The
bigger the resolution, the coarser the DTM.

·

Height threshold: refers to a threshold to classify the point clouds into the ground
and non-ground parts based on the distances between points and the simulated
terrain.

The “preview” button will highlight the terrain elements as green and non-terrain
elements as red. Optionally, you can use a selection to force non-terrain regions.

Tools - Control points and Distances

These functions are not available in 3DF Zephyr Lite and 3DF Zephyr Free.
This menu allows access to certain control points tools.
Scale model with control points: same functionality as shown in the "GCP" tab.
Scale with control distances: same functionality as shown in the "Measures" tab.
Show last alignment information: shows information about the latest "Align model with
3D constraints" operation.
Change current coordinate reference system: allows change of the reference system
of the project. You must have already defined the reference system with control points
before you can change the reference system.
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Print Markers and markers use

The following chapter will explain how to use coded targets in 3DF Zephyr in order to
further improve the cameras orientation phase.
3DF Zephyr’s coded targets are square-shaped (see image below).

In order to print coded targets just click the Tools button in Zephyr’s menu bar and then
on Control points and Distances > Print Markers. You can print up to 24 different
targets.
3DF Zephyr supports 16 bit coded targets: their size strictly depends on the kind of 3D
reconstruction and the related photographic survey as well.
Recommended settings are as follows:
Close Range and Human Body
Urban
Aerial

4 targets per sheet (A4 size)
2 targets per sheet (A4 size)
1 target per sheet (A4 or A3 size)

You can define the amount of targets per sheet by editing the printing menu settings on
Windows (the term “page” implies a target inside that menu).
It is recommended NOT to use coded targets randomly; instead it is highly
recommended to use them in their own numerical sequence (1, 2, 3, 4, etc. and not 4,
13, 22, etc.)
When a photographic survey is completed and after the cameras orientation phase is
done you can start the automatic detection of coded targets by clicking on Tools >
Control Points and Distances > Detect Markers.
In the new window you have to specify:
-

Which is the context where coded targets have been exploited (Urban, Aerial);
Which preset (detection quality) you want to run;
The number of coded targets within the scene;
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After clicking the confirmation button, 3DF Zephyr will start the automatic target
recognition and will set the control points based on the detected targets.
Please note that the automatic target recognition has to be started AFTER having
completed the camera orientation phase in Zephyr.
Tools - Registration

These functions are not available in 3DF Zephyr Lite and 3DF Zephyr Free.
The registration menu allows the user to handle point clouds registration. From this menu
you can access the ICP function ( Iterative Closest Point (ICP) is an algorithm employed
to minimize the difference between two clouds of point ) and see a point cloud difference
report.
Point cloud registration (ICP)
Use this function when you need to align a laser scanned point cloud with a
photogrammetry point cloud: this function considers translation, rotation and scale. Using
this function you can then align a laser scanned point cloud which can later, for example,
be structured and colored with the photogrammetry obtained point cloud.
Multi view point cloud bundle adjustment (Multi ICP)
Use this function when dealing with many point clouds that are already in the correct
scale system, for example multiple scans from a laser scanner device. This function does
not apply any scale factor.
Please remember that:
·
·
·
·

the objects must be close to each other
You can use this tool to register multiple unstructured objects and structured ones
the adjustment and the minimization will be performed in a global way
if you need to register point sets with different scales, it is advisable to use the two
view ICP dialog and enable scaling.

When objects are not close enough (as in most cases) simply use the gizmo
to
bring the point clouds close together. Please refer to 3dflow.net online tutorials for a
visual explanation of this process.
The fist wizard page will ask which objects will interact:

87 / 135

3DF Zephyr

The next page will allow the selection of the reference object. Then, you will be able to
define the object pairings:
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In most cases, pairings should not be changed as they should be automatically selected
so no other interaction from the user is requested. Finally, you can define the stop
conditions before you are shown a recap page where you can start the actual
computation.

Max distance point removal: when two or more point clouds are registered using the
ICP algorithm, the corresponding points are calculated at each iteration by the algorithm
itself.
Since it often occurs that point clouds depict different areas of a certain object/scene, a
procedure to remove too far corresponding points needs to be applied. Indeed, the
registration process would lead to a wrong result without that removal step.
The removal threshold can be calculated:
- automatically (X84 statistical analysis between point distances);
- manually (user is requested to set a metric value);
Point cloud comparison
This function allows computation of a comparison between two selected point clouds. A
chart is then plotted that graphically explains the residuals as a histogram. You can notice
the errors recap on the bottom of the window (mean error and variance). Users should
run this tool after the two clouds have been aligned to each other. Cloud comparison
parameter settings are as follows:
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·

Distance type: indicates the distance to be calculated and users can choose either
"point to point" or "plane to point" distance;

·

Maximum Distance: represents the highest value during the histogram computation;

·

Number of Bins: defines the histogram amount of columns;

As for the residuals computation process:
- The first step computes the closest point of the model for every point of the target;
- If a distance between a couple of points is greater than the maximum distance value,
that distance won't be considered into the computation;
It is also possible to select parts of the histogram to highlight only a certain number of
points of the "model" point cloud directly in the 3D room.
In the 'Point to point' comparison the histogram is built by considering the closest point A
for each point B. All the spatial distances are from A to B are used to build the histogram
and color the point cloud accordingly. The 'Plane' metric is a bit different. In this case a
plane is fitted considering B and its neighbors. The distance is then calculated from A to
the fitted plane. The latter is useful with buildings and walls.

Match objects center
This tool can be used after creating a photogrammetric dense point cloud and importing
then a laser scanner cloud. It often occurs that a scan has been acquired in a different
reference system compared to the one of the photogrammetric dense point cloud. This is
why sometimes users are not able to see the imported scan into the Zephyr's 3D room.
The "match objects center" tool allows to move the imported scan closely to a structured
object, namely the photogrammetric dense point cloud.
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Point cloud registration using control points
When dealing with a very noise photogrammetry point cloud or excessively planar
surfaces (building facades), you may want to use control points prior the ICP alignment.
In this case, the alignment via control point takes just a few clicks and can vastly improve
the results.
The first step is to put at least three control points on the first point cloud you are dealing
with. Depending on what you are doing, you might want to move the photogrammetry
point cloud rather than the laser point cloud. Regardless of this, you will have to then
apply the same control points over the other point cloud.
In this example, we start by importing the unstructured laser scan point cloud inside
Zephyr. After this is done, it is then possible to rescale the imported point cloud and
position it near the photogrammetry point cloud ( although this is not essential )
The next step is now to select three control points. You may pick the control points with
any method, although using images is advised. Try to select control points that later on
you will able to easily recognize and select on the other point cloud: usually, edges work
very well. Keep in mind that you should also select points that are displaced on all three
axis.

When this is done, you can pick the same three control points on the unstructured
objects. Make sure to use easy recognizable names as you will have to manually select
the control points pairing. Note how control points are grouped by object
(photogrammetric point cloud/laser scan) in the “GCP” panel.
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When all the control points have been placed, simply select Tools > Registration >
Control points registration from the menu.

Select which object will move and which one will stay in its position.
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Use the “Add Constraint” button to select the pairings, according to your naming
convention that you used earlier. At least three constraints are required.
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When ready, click “Next” and the summary will appear. Click “Apply” to continue.

At this point, the point clouds have been aligned correctly. An additional ICP step is
advised at this point to minimize errors.

Structuring laser scans:
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Once the registration is completed, simply select the desired dense point cloud from the
“Project” Tab, right click it and then click “Make structured”. Select the options
accordingly to your needs, as shown below:

After the structuring, now you are ready for the mesh generation. Please remember to
select the correct amount of seed points from this dialog according to the level of detail
you want to obtain in your final mesh.
Tools - Sections and Contour Lines

These functions are not available in 3DF Zephyr Lite and 3DF Zephyr Free.
By clicking on Tools > Sections and Contour Lines you can select the drawing element
you want to create choosing from:
·

Single section: this tool generates only one plane that you can move, rotate and
resize; the position of the plane can also be modified using the control points, if they
have been previously placed on the 3D model;

·

Track Sections: this tool generates several planes (user can fix the amount of those)
on each position of the control points so it is worthwhile when it is necessary to draw
sections on an irregular path (for example, a river bed);

·

Contour Lines: allows generation of one or more contour lines on the 3D model and
user can choose the reference axis for contour lines direction;

Each one of the tools above leads to a window after the planes have been placed (see
image below).
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In this window you can draw sections and contour lines previously identified by the planes
both automatically or manually. In the upper bar of the window there are editing and
drawing icons as follows (from left to right):
- Create: manual method that allows you to draw a polyline;
- Remove: removes the vertex of a polyline;
- Move: moves the vertex of a polyline;
- Split: adds vertex to a polyline;
- Clear: deletes all polylines;
- Close Polylines: closes a polyline;
- Smooth Polylines: allows you to smooth all the polylines drawn;
- Autocompute Current: generates a polyline only on the section shown in the window;
- Autocompute All: generates a polyline for each section previously created using the
planes;
- Export: allows export of drawings as .dxf and .shp format;
- Import to Workspace: allows to import drawing elements in Zephyr workspace;
Previous and Next icon allow scrolling among the sections created.
Tools - Lines Extraction

These functions are not available in 3DF Zephyr Lite and 3DF Zephyr Free.
Via the "Lines Extraction" menu, it is possible to add drawing element to the project via a
manual/assisted method or via a completely automated function.
Manual Lines Extraction
Zephyr offers the manual lines extraction feature in two different workflows: one that
requires to define a certain set of points on at least two pictures (given a sparse point
cloud) and one that requires to define a certain set of points in just one picture (given a
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dense point cloud or a mesh).
·

Manual extraction given two images and one sparse point cloud (multi camera
polyline)

In order to extract lines manually, a certain set of points must be defined on at least two
pictures. This is done manually on the first selected picture, while an assisted automated
point detection is offered when selecting other images.
The point definition interface is similar to the one used to define control points, with the
scroll-wheel used to zoom in and out and to pan the image via mousewheel click. On the
right panel, the polyline name can be edited as well as the defined points. The top
toolbar allows to switch from the "add mode" (which adds a new point) to the "edit
mode" (which allows to edit a previously picked point).

After selecting at least two points on the first image, the same points (in the same
sequence) must be selected on another image.
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Points can be selected manually again, or an automatic attempt can be done by clicking
"Automatching". When all the points are defined correctly, you may press OK to finish
and automatically import the new polyline in the workspace, which will be added to the
drawing elements section.

·

Manual extraction given a picture and a dense point cloud/mesh (single camera
polyline)

If at least a structured dense point cloud is available in the workspace, it is possible to
extract polylines with a very similar workspace, however using only image. Thanks to the
dense point cloud, the points projection will automatically extract the desired polyline.
The interface is very similar to the one mentioned above: simply select the desired
polyline points in one image and the reference point cloud to generate the target polyline.
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Automatic Lines Extraction
You may let Zephyr do all the work and automatically extract lines. This process requires
to set a line distance (which makes sense when you have scaled the model to a known
measure) and allows also for a preview per-image. Please note that although all the
automatically extracted lines are grouped togheter in the "Drawing Elements" section,
when exported in DXF, every polyline will have its own definition.
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Drawing Elements & Layers

These functions are not available in 3DF Zephyr Lite and 3DF Zephyr Free.
The Free Drawing tool in the "Drawing" section of the Editing tab allows you to draw
polylines, splines, and surfaces directly on the 3D model.
Please note that drawing elements can be exported into DXF, SHP, DNG and XML
files.
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You can choose the drawing element type (polyline, surface, spline) from the popup
dialog, by pressing the
button.
To create a new separate drawing element, the Create new element checkbox must be
selected.
It's possible to rename the drawing element and change its color before pressingOK.

Once you draw a polyline or a spline, you can close the drawing element by clicking on
another vertex. A popup window will be asking you if you want to close the drawing
element:
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By clicking the Edit button
, it's possible to add, relocate, and remove the selected
point of a certain polyline, spline or surface.
Once the Edit button is pressed, it's possible to move the drawing element vertices by
pressing the Move button

, or delete them with the Remove button

.

The following modes can support you while placing the polyline/spline/surface points in
the 3D workspace:

·

Preview next point allows to have a preview of a point that has not been placed yet.
This mode is handy for splines creation because you can check the curvature trend
while placing the points.

·

Continuous mode allows for automatically placing multiple points while moving the
cursor.

·

Orthographic mode allows for switching to the orthographic view during the drawing
elements creation.

The drawing elements can be grouped into layers regardless of their generation method.
In order to do so, you simply have to select the desired drawing element (you may also
use multiple selection to move more drawings to the same layer), right click and select
the appropriate "move selection to" entry.
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Note: the following tools are available after the drawing elements creation:

Extract control points - allows creating control points from already placed drawing
elements vertices.
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Selection - simply right click on a closed polyline/spline and pick the "use for selection"
option to select points or polygons enclosed by the relative polyline/spline.
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Cutting - right click on a closed polyline/spline and pick the "use for cutting" option to
cut the area enclosed by the relative polyline/spline.
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Merge - Allows to combine separate drawing elements of the same type.
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Properties show information about the selected drawing element. Right click on a
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polyline/spline to choose among Delete, Duplicate as Drawing Elements or Join
option.
Please note that you need to select the drawing elements listed in the properties and
right click the Join option in order to join them together. Once you are done, the
properties will list only one polyline/spline.

Guided BreakLines

To create breaklines, simply click Tools > Lines Extraction > Guided Breaklines, or
select the "Guided Breaklines" option under the Drawing section from the Editing tab.
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Click the
button in the popup dialog to rename the breakline and/or change its color.
Click OK to add the new drawing element to the current workspace.
Breakline creation Settings are as follows:
- Max Segments number: defines the maximum number of the breakline segments to
detect.
- Max Angle degree: sets the maximum angle between two segments
- Explore more during detection: this flag enable a more explorative detection, which
helps recognize more extended profiles on the mesh structure. This option increases the
amount of calculation conditions of the algorithm in order to find longer and more
articulated profiles. You can enable this option if the standard guidance is not good
enough. Be aware that drifts are more likely to occur.
Once you draw the first vertex, you will notice the breakline will point to the vertex
closest to the mouse cursor while hovering the mesh (guided drawing mode). A preview
of the breakline (blue line) will be displayed in the meantime. You have to left-click again
to add the breakline.
Drawing can be paused and resumed by clicking the "Pause" and "Continue" buttons,
respectively.
You can switch between guided and manual drawing mode anytime by clicking the Free
drawing / Guided drawing button.

Note: the segments size of the breakline will be similar to the first drawn segment. In this
respect, the algorithm behavior is highly influenced by the length of the first segment and
it will try to replicate the same length for the successive segments. Therefore, if the
searched profile is extended, it's usually recommended to draw a relatively big first
segment in order to save time. However, please be aware as the segment size
determines the accuracy of the final line.
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Tools - Surfaces Extraction

These functions are not available in 3DF Zephyr Lite and 3DF Zephyr Free.
You can generate surfaces manually using control points or by using our novel blueprint
generation method.
·

Blueprint generation

This function can work on either structured or unstructured dense point clouds. All you
need to do is confirm the automatically detected floor and ceiling planes and select the
extraction method (interiors or exteriors).
You can also set the Epsilon (point to plane distance - points further from this value will
not be considered belonging to the plane) and fusion factor (controls how segments are
generated, a higher value will yield a longer segment and less gaps) if you need further
control on the generation method.

Click "Compute" to start the process. When done, blueprints (polylines) and surfaces
(surfaces) can be added in the workspace by clicking "Save to Workspace". All
elements can be found under the "Drawing Elements" Section.

·

Make surface from control points

Surfaces can be generated by selecting control points. Simply select and add the desired
control points to the shape and click "OK" when ready.
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Tools - Scripting console

These functions are not available in 3DF Zephyr Lite and 3DF Zephyr Free.
You can use this scripting console to customize your own workflow up to a certain
degree of freedom using the Python scripting language.

The Python console has its own manual, especially because these functionality will be
extended with more bindings in the future.
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To generate the Python Console manual, type zephyr.documentation() directly in the
console. A PDF will be generated on-the-fly with the available functionality, as well as
some python examples you can use.
Tools - Options

By clicking the wrench icon in the toolbar or selecting Tools in the menu bar you can enter
the Option window arranged in seven tabs: Application, Appearance, Rendering,
Cuda, Input, Default Names, System. From this window you can tweak and set Zephyr
in appearance, functionality and user experience.

·

The Application and Appearance tabs allow you to set the overall look and feel of
the 3DF Zephyr Window, including language, theme, font size and more.

·

The Rendering tab allows you to edit 3DF Zephyr graphic appearance. You can
modify the colors of several items ranging from the workspace to the grid and control
points.
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Among the most used settings:
- For the viewport, you can change its color and also set a Skybox for your 3D model,
either by selecting from the panoramic default images (source:HDRI Haven) or by
uploading your own panoramic pictures within the "Skies" folder present in the 3DF
Zephyr directory.
- For point clouds generated within 3DF Zephyr, you can change the graphic size of
individual points.
- For the cameras, you can edit at any time the alpha channel which is useful to set
both the images transparency and the size and color of cones detecting shots in
three-dimensional space.
·

You can enable/disable CUDA, either globally or single cards, in the Cuda tab.

·

The Camera tab allows you to set values for the camera movement parameters. Also
allows managing the connection with 3D devices.

·

The Input tab allows managing hotkeys bindings.

·

You can set the desired default names for generated elements in the workspace in
the Default Names tab.

·

In the System tab, you can toggle (and customize) sleep hours, in which Zephyr will
automatically shut down the computer if all computations have finished as well as
define other system options.

·

The Stereo Monitor tab allows managing connection with 3D monitor.

The "Utilities" menu
From this menu you can launch the following Utilities:

3DF Masquerade

3DF Masquerade is the standalone external tool (included in all 3DF Zephyr versions) to
create masks to pair with the images to be processed in 3DF Zephyr. A mask is defined
as a specific selection of one (or more) images that allows to force zephyr to ignore the
corresponding part in a picture. The first time you run Masquerade useful tooltips will
appear on the screen that will teach you the interface basics.
You can find a complete tutorial (and video tutorial) about 3DF Masquerade at the URL
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http://www.3dflow.net/en/technology/documents/3df-zephyr-tutorials/tutorial-usemasking-tool/
You can load images by simply dragging and dropping them in the main window or from
the File menu.
The 3DF Masquerade interface is organized in five main areas:
1. Folder Navigator - browse the loaded images and shows their status - "(M)"
near the filename means that a mask has also been detected in the same directory.
2. Mask editor - shows the current image and the drawn mask
3. Toolbar - allows access to the masking tools
4. Top toolbar - allows quick access to save/load functions, undo/redo, rotate
image and show black and white mask functions
5. Command history - used to undo / redo commands in 3DF Masquerade.

The Rectangle, Polygon and Lasso tools are very similar and most users should be
already familiar with them: to mask a certain area (the area you want to process) you
can:
- drag a rectangle and click the "mask" button to mask the selected area
- use the left click button to add nodes to the polygon path (double-click to automatically
close the polygon) and click the "mask" button to mask the selected area
- drag the lasso and click the "mask" button to mask the selected area.
When the selection has been made, you should see a blue overlay, while when the mask
is being applied, you should see a red overlay.
You may also remove a mask subsection using the "remove mask" button.
Using these tools you can add and subtract different ares by keeping the left control/left
shift keyboard button pressed when doing an action. You may also undo actions using
the CTRL+Z shortcut or by using the command history.
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You may also change the zoom value by using the scroll up/down mouse wheel; you may
also translate the current view by moving the mouse while the mouse wheel is kept
pressed down.
The silhouette tools (red stroke and blue stroke) can be also used to automatically
compute the silhouette of the subject by tracing the foreground element (red, which will
be masked) and the background element (blue, which won't be masked). You may also
quickly swap the foreground/background by using left shift + left click.
You can also delete strokes by dragging the cursor over it and right clicking while
dragging.
This tools is very useful especially when the background has a very high contrast with
respect to the subject that you want to reconstruct.
Finally, a gear shaped function allows you to automatically compute the next silhouette,
very useful especially when dealing with turntables. In this case you should consider
accessing also the "mask by color" function, useful especially when the background is
uniform and in high contrast with the subject.
You may also start the "autocompute" function using ENTER or the "autocompute all"
function using CTRL+ENTER.
The "turntable mode" will also compare the current image to the next one when using the
autocompute function to better draw the silhouette.
All masks are saved as .bim files and are loaded automatically by 3DF Zephyr if saved in
the same directory as the images (as long as you have also checked the "mask images"
button in the project wizard). You may import masks that have been generated outside
3DF Masquerade into 3DF Zephyr using the _masked suffix.
GEOBIM (Revit plugin)

This function is not available in 3DF Zephyr Lite and 3DF Zephyr Free.
Using the geobim dialog in 3DF Zephyr you can enable the Revit plugin service that
allows for synchronization between the two programs.
Please note that this function is still experimental: you can download the plugin from
https://www.3dflow.net/3df-zephyr-plugins-download/3df-zephyr-geobim-revit-plugin/
After opening the dialog, you may select the desired elements in the window. Those
items will be synchronized in Revit after "Import" has been clicked from Revit, in the
"Zephyr Add in" Panel.
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You may also decimate point clouds before those are being sent to Revit: this is advised
for point clouds composed by more than 2M points. You simply have to select the
"decimate point cloud option" and by specifying the desired amount of points to be kept.
Batch processing

This function is not available in 3DF Zephyr Lite and 3DF Zephyr Free.
The Batch processing window allows to schedule certain reconstruction jobs. Jobs
must be defined via XML files, and they must follow the pipeline workflow, at least
partially (this means that you can setup a job from the sparse point cloud generation to
the texture mesh generation, eventually stopping at any of the intermediate step, but you
can not define a job that starts after a camera orientation).
The xml files must be defined in this format:
<?xml version="1.0"?>
<Settings>
<Category name="Batch">
<Entry key="InputDirectory" value="ImagesInputPath">
<Entry key="OutputDirectory" value="OutputPath/>
<Entry key="Phase" value="SamanthaStereo"/>
<Entry key="SamanthaPresetCategory" value="Urban"/>
<Entry key="SamanthaPresetName" value="Fast"/>
<Entry key="StereoPresetCategory" value="Urban"/>
<Entry key="StereoPresetName" value="1_Default"/>
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<Entry key="SurfacePresetCategory" value="Urban"/>
<Entry key="SurfacePresetName" value="0_Fast"/>
</Category>
</Settings>
It is also possible to use the custom parameters directly in the XML. A description of the
categories and the parameters is available when selecting "Custom" during the
reconstruction wizards or by selecting the properties (with the right click) of an element
reconstructed within the workspace. After scheduling one or more job, they will be listed
in the interface, from where you'll be able to start the batch operations.

Run benchmark

The Benchmark tool allows to measure the performance of a machine in order to figure
out if it is suitable for running a 3D reconstruction using 3DF Zephyr.
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The Benchmark will compute a score between 1 and 1000 for each Zephyr phase.
Please note that this function is still experimental
Camera Calibration Manager

The camera calibration manager allows the user to store camera calibrations on the
current system. Although 3DF Zephyr is completely autocalibrated, it is useful to start
from a calibrated device when possible.
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You can import a calibration from the current workspace (if a successful reconstruction
has been completed) or you can load it from our online database by simply feeding a
JPG (with EXIF data). This service is completely free and anonymous.
You can also import and export camera calibrations from/to XML.
This tool is especially useful for computers working offline, as Zephyr will not be able to
check 3Dflow's online database for pre-calibrations.
Preset Manager

The preset manager tool allows the user to manage custom presets for processing.
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You can import presets from the current workspace (if available) or you can create your
own custom one by right clicking the desired category and selecting "Add preset".
If you wish to quickly share a preset with a colleague or a friend, you may also select
"upload preset" by right clicking a previously generated preset. Your preset will be
uploaded and stored anonymously to our server and an ID string will be shown on
screen. You can then select "Import preset from online database " using the same ID.
Please note that anybody with the ID will be able to download it: this service is
completely free and anonymous and 3Dflow does not guarantee persistence of uploaded
presets.
Clicking the "Browse public presets" button will allow you to browse a list of additional
presets. This list is curated by the 3Dflow staff and may change without notice.
Images

Utilities that apply to images files are all grouped under this sub-menu.
Image quality index

The Image Quality Index tool shows a numeric value (and visually in the full version of
Zephyr) the quality of the input pictures. You can simply drag and drop the pictures into
the quality index window, and the score will be automatically computed. Higher score
means higher quality. Please note that this score is computed per picture: it does not use
any 3D information or of workspace information - this will simply compute which areas of
the picture are well in focus and potentially with a high density of keypoints. A high-score
picture does not automatically means that a picture has been shot correctly, however a
low-score picture should be discarded (in green are shown the better areas). Double
click each line to open the visual mode.
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Extract MPO files

This utility allows to extract MPO files. Simply select the MPO files you need to extract
by clicking the "+" sign and click OK to start the MPO extraction process.
Image conversion

This tool allows to convert pictures to .jpeg, .tiff, .png formats.
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It also possible to define the color space as well as to apply Gamma correction and to
remove pictures distortion (the latter option requires a calibration file of the camera
equipment to be loaded).
Decompose equirectangular panoramas

3DF Zephyr can deal with any 360° images by decomposing each picture into 6 pinhole
like cameras using the utility "Decompose equirectangular panoramas". The images
then will be treated normally.

The tool asks to select at least one picture as well as to specify a destination folder.
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8 panoramas and the resultant pictures after the "Decompose equirectangular panoramas" tool has been
exploited

You can select which side of the equirectangular cameras will be extracted by checking
the appropriate side. Since v3.700, 3DF Zephyr will optimize the extracted sides and use
them as constraints during the Structure from Motion phase as long as the filenames of
the extracted cameras will keep the suffixes in the filename ( _left, _right, etc.): Zephyr
will however ask for confirmation in the project wizard.
DEM viewer and profile generation

These functions are not available in 3DF Zephyr Lite and 3DF Zephyr Free.

The DEM viewer utility allows to view DSM and DTM files directly from the Zephyr UI.

Please note that you are supposed to generate an orthophoto before running DEM
generation. To do so, simply click on Workflow > Generate True Orthophoto from
Mesh and follow the wizard for the orthophoto generation.
The DEM viewer utility can be used to:
·

load DSM / DTM files (even those not related to the project you are working on) by
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·
·

clicking on File > Open;
place contour lines on DSM / DTM if they have been previously generated in 3DF
Zephyr, by clicking on View > Show Contour Lines;
export DSM /DTM as a image format (.png, .jpg, .bmp);

Users are even allowed to load the orthophoto as a further layer inside DEM viewer by
clicking on File > Load orthophoto. Here is an example of DEM and orthophoto mixed
together inside DEM viewer:

Elevation profile generation
Inside the DEM Viewer it is also possible to run an elevation profile generation in order to
draw one or more polylines directly on DEM and getting then their elevation profile.
To to draw a polyline on DEM you simply click on Profile > Enable Picking in the DEM
viewer window. By drawing one or more polylines on DEM you will notice that each
vertex will be identified by a number (see image below).
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Once all polyline vertices are placed you can click on Profile > Show info and you can
set number of samples and step size. Also, you can check the tab Points, where each
vertex of the polyline is listed, and the tab Profile as well, where you can see the
elevation profile of the polyline (see image below).
Moreover, by moving the cursor you can see the quote of every single profile point in
detail.

You can also export an elevation profile either as .pdf/.svg format or .dxf format by
clicking on Export buttons below.

Launch camera calibration

The Launch camera calibration utility opens 3DF Lapyx, with an easy to use wizard to
compute the camera calibration. Follow the on screen instruction if you wish to
precalibrate your camera. You won't need to print anything: the pattern will be shown on
the screen and that is what you need to photograph.
Multispectral

These functions are not available in 3DF Zephyr Lite and 3DF Zephyr Free.
Radiometric calibration and multispectral viewer are accessed from this menu, while
multispectral orthophoto composition is directly managed from the Orthophoto generation
function in the Workflow menu.
Launch radiometric calibration

Although not mandatory for processing, it is advisable to take pictures to calibrate your
multispectral camera before the actual flight. With this tool, those images can be used for
the calibration process.
3DF Zephyr currently supports the MicaSense RedEdge sensor and thermal images
taken with DJI devices.
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After launching the wizard, select your input and output directories from the wizard.

In order to enable the "next" button, you then must select any image that views the
calibration panel. 3DF Zephyr will automatically find the panel images for each band.
After clicking the next button, you will be asked to draw a square over the calibration
panel on each of the available bands.
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Once you have drawn the square over all the detected bands, the "Run Calibration"
button will be clickable. Click it in order to proceed with the calibration process. Once the
process is complete, a summary will be shown, where you'll be able to click any image in
order to see the result of the calibration.

Multispectral viewer

Similarly to the DEM viewer, this utility allows to view TIFF files. However, this utility also
allows to select the colormap from the view menu.

129 / 135

3DF Zephyr

Other
System info

Opens the system monitoring panel. you can toggle the desired information by clicking
the desired item shown in the list on the right side of this panel.
DSLR remote shooting

This utility requires the download and installation of the DSLR remote shooting plugin
available from http://www.3dflow.net/remote-dslr-sync-shooting-plugin-download-3dfzephyr/
Please note that this utility is still to be considered in beta. At the moment of writing, this
plugin only supports Canon DSLR cameras.
In order to launch this utility, you must first install the plugin: once you have done so, turn
on your cameras, connect them to your PC and then launch the utility: the utility will not
detect newly connected cameras so you must restart the utility in case you need to
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connect additional cameras.

Once you have selected the output directory, you will see the detected cameras in the
interface as a list : each row corresponds to a camera. You may change ISO, Av and Tv
settings physically on a target camera (you will see the changes happen in real time in
the cameras list) and then use the appropriate "propagate" button to propagate those
settings to other cameras.
Please note that other settings (white balance, etc.) have to be setup manually on each
camera.
You may use the appropriate "Take shot" to take a picture from a specific camera or
use the "take picture on all cameras button": please note that in this last case, there is a
delay (about 100ms) for each connected camera.
If you need synchronization, you should trigger simultaneously the cameras, for example
with a radio control.
Notes about the physical setup: although theoretically Zephyr could handle a number of
cameras that is limited by the physical USB ports available, it is advised to limit to 16
cameras for notebooks and 32 for desktops. Please also remember that USB cables
should not be longer than 5m and if possible avoid using USB hubs.
3DF Zephyr Lite has a hard limit of two cameras.

Handle laser scanner point clouds
Since version 3.0, Zephyr supports laser scan native format files.
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In order to install native laser scan support, you have to install the free plugin for the
desired format from http://www.3dflow.net/native-laser-scanner-support-plugin-3dfzephyr-download/
3DF Zephyr Lite and Free can open (as viewer) laser scan format files as well, while the
full version of 3DF Zephyr also have the option to import those file in the workspace.
3DF Zephyr supports the following native format files from the following laser scan
device manufacturers:
·
·
·
·
·

Faro (.fls, .flw)
RIEGL (.rdbx)
Dot Product (.dp)
Z+F (.zfs)
Recap (.rcp)

Custom shaders
Since verson 3.500, a new shading system has been employed that allows advanced
users to write and customize the shading used by Zephyr.

You can select the shader using the

button in the toolbar.

You can then switch 3DF Zephyr default shader or write your own. You can find a test
shader installed alongside Zephyr.

Troubleshooting
3DF Zephyr is a very complex software: in this section, you'll find some general
troubleshooting hints as well as some frequently asked questions.
First ad foremost, please remember that you can contact the tech support at the email
address support@3dflow.net or on the forum at the URL http://www.3dflow.net/forums/
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When contacting the tech support, please try to have these information ready:
·

Operating System and Hardware specifications

It's very helpful for us to know which platform Zephyr is running on. Please let us know,
at a minimum, your operating system as well as its hardware specs (at least CPU, RAM
and Video Card)
·

Log files

Zephyr logs a lot helpful information on text files that are saved in your %appdata%
directory - you may eaccess this directly easily from the Zephyr options menu by
selection the "Application" tab and then clicking on the "Open Log Folder" directory.

Make sure to attach the relevant log files in order to help us pinpoint the cause of your
issue.
After contacting us, you will be contacted by our tech support.

FAQs
Some common questions can be answered here:
I get a numeric error message on startup and Zephyr cannot be activated, what
can I do?
Make sure that you are connected to the internet when activating your product and that
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the time and date on your system are correct. If you are using a trial key, please
remember to activate it within 14 days of generation.
Zephyr can't write on hard disk, what can I do?
Make sure that no other software is preventing Zephyr to access the file system. In any
case, you may specific an arbitrary temporary directory from the options menu.
Can I install 3DF Zephyr on more than one computer with one license?
You can uninstall and install 3DF Zephyr as many times and on as many computers as
you need. The only requirement is that there can be only one simultaneously installed
copy of Zephyr on your computers. If your license allows you more than one installation,
than that limitation applies.
I'm experiencing problems/crashes with 3DF Zephyr. What should I do?
3DF Zephyr is a complex software, so it's hard to tell without further information. Post on
the forums or send us an email, describing your problem and don't forget to attach the
logs!
How do I use the developer console?
Please consider that this feature is for support only, things will break if not used
correctly. The console uses LUA 5.3.1 but no external dependencies are needed.
Which is the difference between Constraints and Control points?
Let's think about an aerial capture where you have both coordinates taken by a GPS
system on drone and some coordinates on the ground taken with a total station for
instance.
After you have placed your points in Zephyr, you can choose which points must be the
constraints, namely the points you are confident (of their accuracy) the most, and which
points will be taken into account as simple references.
The first group will be the points taken on ground with the total station since their
accuracy is definitely higher than GPS coordinates taken by the GPS system on drone,
that represent the second group.
How can I ignore GPS data before performing my 3D reconstruction?
Simply click on Tools > Option > Application and disable "Allow Structure from Motion to
use GPS information from cameras" option.
Which is the difference between structured objects and unstructured objects?
An object (photogrammetric clouds or scans) can be named "structured" when it includes
the origin's point of its element (laser scanner devices rather than pictures). Native laser
scanning file formats usually include the origin's point as well as other formats such as
the E57 one. Other formats such as the .las one never provide the origin's point.
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Performance tweaking
Please always make sure that Zephyr is running on a computer with the latest NVIDIA
and CUDA software updates (when possible).
3DF Zephyr takes advantage of the CUDA technology, so running Zephyr on a machine
with one (or more!) NVIDIA cards is strongly advised. If you are considering an hardware
update, make sure to consider:
- adding a SSD drive if you don't own one already
- adding an NVIDIA card
- adding more ram (depending on the size of your datasets)
- using a faster CPU
Disable coloring if you don't need it
If you are only interested in getting a textured model, there is no need for the
intermediate steps to compute the color in the point cloud and mesh generation. You can
disable coloring from the general application options dialog. You may also right click an
element and select "update colors" if you wish to compute them for a specific one.
Use a unified and persistent cache directory
You can also use a unified and persistent cache directory. Please note that this is not the
default behaviour, as it will use a lot of available space and you will have to manually
clean it.
We strongly suggest you run 3DF Zephyr on a workstation that has a SSD drive. If your
windows installation is on a mechanical drive and you have another SSD drive, you may
also consider switching the temporary directory on that drive.

Running Zephyr via remote desktop
Zephyr requires OpenGL 1.4 in order to render its interface: please keep in mnd this
when controlling Zephyr via remote desktop (both from a physical machine or from a
virtual machine).
Microsoft RDP (until Windows Server 2019) does not support OpenGL 1.4 - you
must use a remote desktop client that supports OpenGL 1.4, for example Splashtop or
Hamachi Logmein if your Microsoft RDP version does not support OpenGL 1.4.
Please also note that even virtual machines must have their correct drivers installed.
Make sure that you have your graphics drivers up to date. In some rare cases - i.e. when
a video card has just arrived on the market - you may need to install the developers
NVIDIA driver available at the URL https://developer.nvidia.com/cuda-downloads until the
newer version of Zephyr takes care of that.
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